
flexImaging 5.0
Workflows Manual

Revision D (April 2018)

1839454



Legal and Regulatory Notices Bruker

Legal and Regulatory Notices

Copyright © 2018

Bruker

All other trademarks are the sole property of their respective owners.

All Rights Reserved

Reproduction, adaptation, or translation without prior written permission is prohibited,
except as allowed under the copyright laws.

Document History

flexImaging 5.0WorkflowsManual Revision D (April 2018)

Part number: # 1839453

First edition: October 2015

Warranty

The information contained in this document is subject to change without notice.

Bruker makes no warranty of any kind with regard to thismaterial, including, but not limited
to, the implied warranties of merchantability and fitness for a particular purpose.

Bruker is not liable for errors contained herein or for incidental or consequential damages
in connection with the furnishing, performance or use of thismaterial.

Bruker assumes no responsibility for the use or reliability of its software on equipment that
is not furnished by Bruker.

This software is based in part on the work of the Independent JPEGGroup.
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Use of Trademarks

The names of actual companies and products mentioned herein may be the trademarks of
their respective owners.

Limitations on Use

For General Purpose Use

(In the United States, Japan and Taiwan: For Research UseOnly (RUO))

This product has no declared clinical intended purpose and is not for clinical diagnostic
use. Any clinical diagnostic use is at the user's own risk and responsibility.

Hyperlink Disclaimer

Bruker makes no express warranty, neither written nor oral, and is neither responsible nor
liable for data or content from the linked Internet resources presented in this document.
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Contact Bruker

Contact

Contact your local Bruker Daltonics representative for service and further information.

USA Germany
Bruker Inc
40Manning Road
Billerica, MA 01821
USA

Bruker DaltonikGmbH
Fahrenheitstrasse 4
28359 Bremen
Germany

Phone: +1 978 6633660

Fax: +1 978 6675993

Internet: www.bruker.com

Phone: +49 421 2205-350

Internet: www.bruker.com

Support

Phone: +1 877 442 2231

Email: ms.support.us@bruker.com

Phone: +49 421 2205-345

Email: maldi.sw.support@bruker.com
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Bruker 1 Preface

1 Preface

1.1 Key Features 8

1.2 Patents 8

flexImaging 5.0 (referred to as 'flexImaging') is a program designed to acquire spectra in a
spatially resolvedmanner directly from the surface of samples such as tissue sections. The
results can then be visualized as images representing the spatial distribution of molecules
within the sample. Commonly, this approach is referred to asMALDI imaging.

Data acquisition on all Bruker instruments equipped with a MALDI source is supported;
specifically flex series MALDI TOF (Time-Of-Flight) instruments (for example, autoflex,
ultraflex and rapifleX) andMALDI-FTICR (solariX).

flexImaging is composed of two parts: a graphical run editor and an analysis and
visualization component, which are integrated seamlessly into an easy- to- use graphical
user interface.

For time-of-flight mass spectrometers, flexImaging works in conjunction with flexControl
and flexAnalysis (versions 3.4 and 4.0). flexControl is used to operate the mass
spectrometer and acquire spectra, whereas the flexAnalysis is used for spectra post-
processing. For fast acquisition on the rapifleX, data processing is performed during
acquisition and is independent of flexAnalysis. In this workflow, flexAnalysis (and the
flexAnalysis Batch Process tool) are only required for post-acquisition reprocessing of
data.

For an FTMS spectrometer, flexImaging operateswith ftmsControl (version 2.0).

In addition, flexImaging also provides several possibilities to import and export results for
further analysis. Most importantly, flexImaging interfaces with SCiLS Lab for statistical
analysis of MALDI Imaging data.
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1.1 Key Features

The flexImaging software has the following key features:

l Integrated solution for acquisition, visualization, and analysis of MALDI imaging
data.

l SupportsMALDI-TOF (flex series) and FTMS (solariX) instruments.

l Registration and superimposition of image (s) to compare the distribution of
molecules with histology , including virtual microscopy data from special slide
scanners.

l Configurable spectra import (data reduction, mass range truncation) for handling
large data sets. Storage of reduced data sets for fast reload of analyses.

l Customizable display of overall average, region of interest average, and single
spectra.

l Fast and simple creation of ion distribution images (mass range filters).

l Interface to SCiLS Lab for performing statistical analysis.

1.2 Patents

The product is protected byU.S. Patent(s) No. 5808300.
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2 Workflows in Detail

2.1 Sample Preparation 9

2.2 Data Acquisition 32

2.3 Data Acquisition Using HyStar and ftmsControl 83

2.4 Data Processing and Interpretation 88

2.1 Sample Preparation

2.1.1 Preparation of Cryostat Sections for MALDI Imaging 9

2.1.2Matrix Coating with imagePrep 15

2.1.3 Robotic Spotting 19

2.1.4 Specific Considerations for Detecting Pharmaceuticals in Tissue 21

2.1.5 Preparing a Drug Dilution Series in a Frozen Tissue Homogenate Block 23

2.1.6 Acquiring anOptical Image 29

2.1.1 Preparation of Cryostat Sections for MALDI Imaging

General remarks

Cryosections of fresh frozen tissue are best suited for MALDI imaging and the quality of
tissue samples is crucial for the results.

Tissue should be frozen immediately after harvesting with no additional treatment such as
perfusion or fixation. If possible, blood and connective tissue should be removed.

Small tissue samples can be easily snap frozen in liquid nitrogen, for larger specimen it
may be necessary to use isopentane (cooled with liquid nitrogen or dry ice) to ensure that
the sample is thoroughly frozen. If liquid nitrogen is not available, freezing the tissue in a
freezer at –80°C or with powdered dry icemay be sufficient.
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The sample should not be embedded in supporting material such as optimal cutting
temperature polymer (OCT), which contains polymers. These polymers are detectable by
mass spectrometry and their signals may suppress other analyte signals. Solid tissue such
as brain, liver, kidney, tumors can be cut in a sufficient quality without any embedding.
Less compact samples (e.g. whole body sections, or delicate organ tissue such as lung or
heart) need to be embedded for good quality sections. In this case the samples can be
embedded using water or PBS buffer. If embedding cannot be avoided, see the following
section “Preparation of tissue that is embedded inmountingmedium”.

Sections should be deposited onto conductive ITO-slides (coated with indium tin oxide for
conductivity, Bruker Daltonik Part No. 237001 "Glass slides for MALDI imaging"). Inside
the slide package, the conductive side of the slides is indicated by an arrow. The slides
themselves are not marked, but conductivity can be tested using a multimeter. It is
possible, but less convenient to prepare the samples onto normal steel targets. Normal
non-conductive glass slides cannot be used.

A few histological stains are compatible with subsequent MALDI imaging, which can
enable the histologically directed selection of measurement regions for MALDI imaging.

For detailed information please refer to: Chaurand P, Schwartz SA, Billheimer D, Xu BJ,
Crecelius A, Caprioli RM, Anal. Chem. (2004), 76(4): 1145-1155.

However, in most cases, histological staining is best performed after the MALDI imaging
experiment: it is then possible to co-register a microscopic image of a stained section with
the imaging data.

Depending on the experiment, it might be necessary to conduct conventional histological
staining on consecutive sections collected on standard glass slides in parallel.
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Figure 2-1 Glass slides for MALDI imaging from Bruker; the arrow indicates the
conductive side

Polylysine coating of glass slides (optional)

Because of the hydrophobicity of the conductive coating, some tissue sections do not
adhere perfectly to ITO-slides. As a result, sections may detach from the slide in post-
MALDI histological staining or may lose integrity (e.g. cracks, ruptures or folded edges).
These effects can be avoided by coating the ITO slides with polylysine prior to the sample
preparation.
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Required materials:

l Poly-L-lysine Solution, 0.1%w/v in water, Sigma-Aldrich P8920

l Igepal CA-630, Sigma I7771 (used to be called Nonidet P40).

l Glass spreader

l Heated plate (optional)

►► Procedure

1. Dilute 750 µL polylysine solution in 750 µL water and add ~1 µL Igepal.

Note Igepal is very viscous and difficult to dispense.

2. Dispense 20 µL of the mixture onto the slide, distribute it using a glass spreader and let
dry on the heated plate (~80°C) or at room temperature.

The slide should be evenly coated with a thin film. If the liquid forms individual patches
instead, addmore Igepal to themixture.

Remarks

Igepal is a polymeric detergent, which generates several signals in the mass range below
1000 Da. Therefore, the amount of Igepal used should be as small as possible. When
measuring a low mass range, it might be necessary to omit the polylysine coating
completely.

Required materials

l Cryostat

l Conductive slides or aMALDI target

l Optional: Artist's brush for small sections or forceps for large sections

l Two Petri dishes or Coplin jars

l 70% and 96%Ethanol (Histology-grade)

l Vacuum desiccator

l Slide containers or aluminum foil

Note The cryostat blade should be wiped with ethanol prior to cutting to remove
traces of oil, OCT and other contaminants that remain from earlier
preparations.
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►► Preparing a cryostat section for MALDI imaging

Appropriate thickness of the section is 10 to 20 µm; 10 to 12 µm is ideal for most samples.
(According to Yuki Sugiura, Shuichi Shimma, Mitsutoshi Setou, J. Mass Spectrom. Soc.
Jpn. (2006), 54 (2), pp 45-48 "Thin Sectioning Improves the Peak Intensity and Signal-to-
Noise Ratio in Direct Tissue Mass Spectrometry" the thinner the sections, the better the
spectra will be if a spray preparation is used).

1. Place the conductive slides and the brush inside the cryostat and wait until they
reached the cryostat temperature.

2. Cut a tissue section.

3. Transfer the section onto the conductive side of the cold slide. There are two
possibilities to do this: Either the section is picked up with the artists brush or the
forceps and transferred to the slide, or the tissue is picked up directly with the cold slide
from the blade (the latter is not possible with a steel target). Transferring the section to
a warm slide directly off the blade may result in reduced signal intensity, especially
when analyzing proteins.

4. Thaw-mount the section onto the slide.
o Carefully press the underside of the slide on the back of your hand. This should be
sufficient to gently warm the slide and tissue section.

o Keepwarming the slide until all moisture has evaporated from the section.
o Note : Exercise caution. Glass slides can break easily if you apply to much
pressure.
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Figure 2-2 Warming the slide on the hand to prevent condensation

5. Take the warm slide out of the cryostat.

6. If more than one tissue section is to be placed on one slide, the slide can be re-frozen
inside the cryostat now.

7. Desiccate the slide for at least fifteen minutes in vacuum (brain sections should be
desiccated for up to 45minutes).

8. Prepare two Petri dishes or Coplin jars with 70% ethanol each and one with 96% or
pure ethanol. Wash the slide twice for 60–120 seconds in the 70% ethanol and once
for 30–120 seconds in the pure ethanol. If small peptides (e.g. neuropeptides) are in
the focus of interest keep the washes very short, for drugs or lipids skip the washing
steps completely.

Note: Sample pre-treatment has considerable influence on the results of a MALDI
imaging experiment. The procedure above is only a starting point. Optimization may be
required for specific samples or target molecules.

9. It is useful to write a sample code or number onto the slide now, preferably in a defined
corner. This will both help keeping track of the sample and also of the orientation of the
slide later in the experiment.

10. Desiccate the slide in vacuum oncemore. The sample is now ready; it can be stored for
a few days in the desiccator at room temperature or frozen at –80°C for longer storage.
If the samples are to be frozen, we recommend either packing them individually in a
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separate slide container or wrapping the individual slides in aluminum foil, to prevent
condensation of water on all slides if a section is later removed from the freezer.

Figure 2-3 Labeled slide in aluminum foil before storing

Preparation of tissue that is embedded in mounting medium

Embedding tissue in mounting medium (such asOCT) should be avoided. However, there
may be reasons to use embedded tissue: The tissuemay have been embedded during the
tissue banking or the tissuemay be so delicate that it cannot be cut without embedding.

For the preparation of OCT embedded tissue, proceed as described in the preceding
section.

At step 8: Prepare an additional Petri dish or Coplin jar with warm water. Wash the slide
twice for 30–120 seconds in 70% Ethanol and once for 30–120 seconds in pure Ethanol.
After this, dip-wash the slide several times in the water (5 to 10 short dips). (Adapted from:
Cazares LH, Troyer D, Mendrinos S, Lance RA, Nyalwidhe JO, Beydoun HA, Clements
MA, Drake RR, Semmes OJ. Imaging mass spectrometry of a specific fragment of
mitogen-activated protein kinase/extracellular signal- regulated kinase kinase kinase 2
discriminates cancer from uninvolved prostate tissue. Clin Cancer Res. 2009, 15
(17):5541-51)

2.1.2 Matrix Coating with imagePrep

Please refer to ftp://ftp.bdal.de/data/Support/TOF/compass-flex/flexImaging/pdfs/.
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The Bruker imagePrep device is the recommended means for coating the matrix. It is a
convenient and easy-to-use push button system that performs a high quality homogenous
coating and enables high spectrum quality. Prior to coating the sample with imagePrep it is
necessary to apply teachmarks and to take an optical image.

Preparation of sections

See section 2.1.1.

Required materials

l Liquid correction fluid (for example, Tipp-Ex®).

l For the list of required materials for matrix coating with imagePrep please refer to
the imagePrepmanual.

Teach marks

flexImaging needs an optical image of the sample that will be aligned with the sample on
the sample carrier inside the instrument.

Usually, it will not be possible to recognize the tissue section underneath the matrix layer.
To correlate the optical image with the sample in the instrument, it is helpful to have teach
marks that are visible both on the optical image and underneath the matrix layer in the
camera optic. The easiest way is to spot at least three correction fluid marks around the
sample before taking the optical image. The correction fluid is visible through the matrix
layer and can easily be used for teaching.

Figure 2-4 Teach marks made with correction fluid
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Take optical image now!

Because the tissue section cannot usually be seen underneath the matrix layer after the
spray coating, we highly recommend acquiring an optical image of the section (see section
2.1.6) before starting thematrix coating!

Coat the matrix with imagePrep

Please refer to the imagePrepmanual for how to proceed from here.

Mounting the slide into the slide adapter

Please refer to the product information of theMTP slide adapter on how tomount the slide.
It is necessary to wipe off the matrix layer from the left and right edges of the slide to
ensure a good conductive contact between the metal adapter and the ITO-coated glass
surface. The area on the slide that ends up underneath the washers of the slide adapter
must be clean.

Transfer coordinates on plastic lid

Because the field of view of the instrument camera is rather small, it may be difficult to find
the sample in the adapter inside the instrument. It is useful to take the plastic lid (which
covers a target during shipping) and put it onto the sample carrier with the mounted
sample.

Next, mark the position of the sample and the teachmarks on the lid with a non-permanent
pen. Placing the marked lid on a regular MTP target plate will allow you to easily read off
the coordinates of the sample and teach marks. Once the slide adapter is inside the
instrument, you can easily move the adapter to these coordinates using flexControl. The
lid can be cleaned with ethanol for reuse.
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Figure 2-5 Transferred tissue coordinates and teach marks on plastic lid
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2.1.3 Robotic Spotting

A robot can be used to spot small matrix droplets on a tissue section. The advantage of
using these robotic microdroplets for the matrix application is typically a higher signal to
noise ratio in the resultingmass spectra and a higher spot-to-spot reproducibility.

Details for the spotting are different for each robot, please refer to manufacturer's
instructions.

General hints for robotic matrix spotting

A relevant amount of matrix is required to allow crystal formation and spectra acquisition
from a tissue sample. The amount of matrix deposited in a single droplet by a robotic
spotter is usually too low, so repeated spotting is usually required. Generally, as droplet
volume becomes smaller, each individual spot position may have to be spotted with matrix
more often. Re- spotting before the previous droplet is completely dry may improve
spectral quality by improving analyte extraction. These parameters must be optimized
experimentally.

If the robot has a nozzle, matrix crystallization at the nozzle may have a detrimental effect
on the spotting accuracy. In such a case it is helpful to use are more diluted matrix solution
and to spot more often.

General hints for acquiring the optical image

For samples spotted with droplets deposited by a robot, a sample image should be taken
after matrix application. This should be used as the primary image when setting up the
data acquisition in flexImaging, and allows precise teaching of thematrix droplet positions.

If desired, acquire an optical image of the sample before robotic spotting for co-registration
with the imaging results.

Spot microarrays

A spot microarray is an rectangular array of matrix spots on tissue with constant spot- to-
spot distances.

The upper-left, upper-right and lower-right droplet positions are used for teaching.

flexImaging 5.0 Workflows Manual Revision D Page 19 of 152



2 Workflows in Detail Bruker

Figure 2-6 Spot microarray on rat brain section. Spots used for teaching are
indicated by arrows.

The borders of the microarray should be roughly parallel to the edges of the slide of the
MALDI target. flexImaging can correct smaller deviations, but will fail if the array is tilted
toomuch.

Details on how to set up the imaging run in flexImaging can be found in the reference
section.

Tissue profiling

In tissue profiling workflows, the robotic droplets are spotted on specific spots of interest
on the tissue. Data will only be acquired from these spots of interest, allowing for much
faster data acquisition. Instead of a full MALDI image of the sample, a "profile" spectrum
for each spot of interest will be generated. Please refer to tissue profiling for a detailed
description of the workflow.
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Figure 2-7 Tissue profiling on rat cerebrum

2.1.4 Specific Considerations for Detecting Pharmaceuticals
in Tissue

Unlike the preparation of samples for peptide, protein, or lipid imaging, there are no
standard protocols for the detection of pharmaceuticals in tissue. Pharmaceutical
compounds exhibit a huge range of physicochemical properties such as solubility, basicity,
and so on. For each compound, the best preparation protocol and the detection limit for a
given tissue has to be determined experimentally. The parameters that have to be
evaluated include choice and concentration of matrix and solvents.
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Intital experiments to determine detection limits for a particular compound under ideal
conditions can be performed using a dilution series on a regular MALDI target plate. The
detection limit of a compound may be very different in a complex mixture of molecules
(such as tissue), so a dilution series that is spiked as droplets on a tissue sample is also a
accessible model system for initial experiments.

Some hints for the sample preparation are:

l Use a dilution series of the pharmaceutical compound spiked as droplets onto a
tissue. Start with high concentrations (much higher than expected in the dosed
tissue).

l Compare different matrix substances to see which allows the lowest detection limit.
This can be done by pipetting the matrix onto the tissue without worrying about the
spatial resolution. It is often helpful to spot the matrix twice to get a good
crystallization. The tissue profiling mode in flexImaging is helpful to measure these
matrix spots.

l Try different matrix solvents, from polar to non-polar. Because the drug needs to be
extracted from the tissue into the matrix, this may have a huge impact. The solubility
of the compound in a particular solvent can be a good indicator.

l When the best matrix and solvent combination is found, sample preparationmust be
adapted to achieve spatial resolution in a MALDI imaging experiment. For this a
more realistic model system (such as a spiked tissue homogenate that is re-frozen
and sectioned) is required. This can also be used to determine the detection limit
under more realistic conditions.

l Detection of the compound may be subject to ion suppression by endogenous
molecules. Ion suppression in tissue can be evaluated by spiking a chemically
similar reference compound into the matrix as a standard, and observing the signal
intensity in different tissues.
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2.1.5 Preparing a Drug Dilution Series in a Frozen Tissue
Homogenate Block

Tissue homogenate spiked with drug molecules is a good model system for the
development of sample preparation techniques for MALDI imaging of drugs without the
need for dosed animals.

It can be used to:

l Find the optimal matrix and solvent for the drug.

l Establish and optimize the limit of detection.

l Calculate a calibration curve for quantification.

IMPORTANT Before starting this procedure, confirm that a signal from a 1 in 20 dilution
of the drug stock solution can be measured using a dried droplet
preparation on a stainless steel target.

Required materials

l Fresh tissue

l Disposable syringes (5mL)

l Drug stock solution

►► Creating a tissue block with drug-spiked homogenate plugs

1. Homogenize the tissue and pass through a fine sieve.

2. Divided the homogenate into 1mL aliquots and freeze at –80°C.

3. Prepare a cylindrical block of frozen homogenate with four channels for drug-spiked
homogenate plugs.

a. Cut the end off a 5mL disposable syringe.

b. Withdraw the plunger to leave a volume of around 2 mL at the open end of the
syringe.

c. Deposit 2 mL of thawed homogenate in the open end of the syringe

Avoid introducing air bubbles.
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Figure 2-8 Cut the end off a 5 mL syringe and fill with 2 mL homogenate

d. Freeze the homogenate in the syringe by placing it at –80°C for at least one hour.

e. Drill four 1.5 mm diameter channels through the frozen homogenate block and
syringe plunger.

Work quickly to avoid thawing.
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Figure 2-9 Drilling holes through the frozen homogenate block

d. Store the syringe with the drilled homogenate block at –20°C.

4. Thaw four 1 mL homogenate aliquots and add drug stock solution according to Table
2-1.

Carefully stir the spiked homogenate samples at 0°C.

Table 2-1 Preparation of drug-spiked homogenate

Final drug concentration (mg/kg) Drug stock solution (1 g/L)
added to 1 mL homogenate

50 50 µL

20 20 µL

5 5 µL

1 1 µL
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5. Deposit each spiked sample into a separate channel in the frozen homogenate block
prepared in step 3.

Figure 2-10 Transferring the spiked homogenate to the frozen homogenate block
channels

Transfer the homogenate using a disposable syringe with a pipette tip attached to the
nozzle.

Work quickly to prevent the frozen plug from thawing.

Completely fill each channel.

6. When all channels are filled, immediately transfer the frozen block containing the
spiked homogenate plugs to a freezer at –80°C for at least one hour.

Page 26 of 152 flexImaging 5.0 Workflows Manual Revision D



Bruker 2 Workflows in Detail

7. Prepare the block for cryosectioning.

a. Deposit O.C.T. compound onto the cryostat sample stage.

b. Place the open end of the syringe containing the frozen homogenate block onto the
O.C.T. compound.

c. Warm the barrel of the syringe around the frozen plug with your fingers until the
plug can be pushed out using the plunger.

d. Remove the disposable syringe when the plug is fixed on the sample stage with the
frozenO.C.T. compound.

Figure 2-11 Placing the frozen homogenate block onto O.C.T. compound on the
cryostat stage

The spiked homogenate block is now ready for cryosectioning.
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Figure 2-12 Example tissue homogenate block with spiked plugs containing different
drug concentrations

Figure 2-13 MALDI MS image of a drug spiked into liver homogenate
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2.1.6 Acquiring an Optical Image

Acquiring an optical image of the sample is an integral part of theMALDI imaging workflow
as implemented in flexImaging. This image allows easy selection of measurement regions
and provides the primary coordinate system to correctly display results. Bruker provides a
slide scanner (plustek OpticLab H850) that is ideal for acquiring images of tissue sections
mounted on regular size (25 mm × 75 mm) ITO slides, but essentially any device capable
of acquiring a digital image of reasonable quality can be substituted.

Basic requirements for the optical image

1. Visible teachmarks or other reference points.

To align the optical image with the actual physical position of the sample inside the
instrument source, at least three reference points or teach marksmust be highly visible
both on the optical image and on the image of the instrument camera. We
recommended applying teach marks using correction fluid (for example, Tipp-Ex®)
before acquiring the optical image (see section 2.1.2). Other prominent features (such
as tissue margins) may be used, but are usually difficult to identify once the sample has
been coated with matrix.

2. Reasonable size and resolution.

flexImaging 5.0 will automatically scale the resolution of the optical image provided to
allow proper visualization of MALDI imaging data up to the minimum raster width (as
defined on the Instrument tab of the flexImaging Preferences dialog). No user
interaction is usually required. If the optical image covers a particularly large area
(>100 cm2) or is of low resolution (<1200 DPI), the minimum raster width must be
increased by the user. In addition, if a very small raster width is desired (<5 µm), the
area covered by the optical image should be considerably smaller (<25 cm2).

3. Matching orientation.

The optical image must have roughly the same orientation as the physical sample on
the sample carrier. flexImaging corrects for slight tilting of a few degrees, but it may be
necessary to rotate or flip the optical image beforehand using an image viewer
software such as IrfanView.
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4. File Format.

flexImaging supports the following optical image file formats:

l bitmap (*.bmp), JPEG (*.jpg), and 8-bit/24-bit TIFF (*.tif)

2.1.6.1 Using different devices to acquire an optical image

Diapositive scanners (recommended)

Some diapositive scanners can be equipped with an adapter for microscopic slides. Using
such a scanner is themost convenient way to work with flexImaging and is therefore highly
recommended. Images generated by such scanners are much better in quality than from
office scanners and their resolutionmatches the requirements for flexImaging.

Microscopes

Most microscopes will have only a limited field of view that cannot image the entire tissue
section and so usually cannot be used to acquire the optical image. Some microscopes
can stitch together multiple images to create a larger optical image than the field of view.
Such microscopes can be used for optical image acquisition, but usually create very large
files due to the high resolution, which may cause the automatic image scaling in
flexImaging to fail. In this case, use an image viewer software to reduce the resolution to
~4000 DPI.

Gel scanners

Gel scanners are able to acquire an image of the tissue section on the slide in transparent
mode. This is recommended. If the glass slide is placed directly on the glass surface of the
scanner interference pattern may be seen in acquired image. These can be avoided by
placing paper spacers under two edges of the slide and thereby creating a small gap
between the scanner surface and the slide. Glass cover slips can also be used as spacers.
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Figure 2-14 Scan of rat liver tissue section acquired with a gel scanner

Figure 2-15 Using a gel or office scanner in transparent mode

Office scanners

If the scanner has a transparency mode, it is recommended to use this mode. If the glass
slide is placed directly on the glass surface of the scanner interference pattern may be
seen in the acquired image. These can be avoided by placing paper spacers under two
edges of the slide and thereby creating a small gap between the scanner surface and the
slide.

If the scanner has no transparency mode, then the following procedure can be used to
acquire a good image: Use two paper strips or glass cover slips as spacers to avoid direct
contact of the tissue sections with the scanner. Place the slide with the tissue section
facing downwards onto the spacers. Cover the entire assembly with a black paper or
cardboard. Now acquire the image.
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Figure 2-16 Scanning a tissue section with an office scanner without transparent
mode

Digital cameras

Digital camerasmay be used to acquire the optical image, but are not recommended. If the
camera is not aligned perfectly parallel to the sample carrier, the image will be distorted in
a way that cannot be compensated by flexImaging, which may cause a misalignment
between the optical image and the MALDI imaging results. The mass spectra may
therefore be not acquired at the expected positions, and the interpretation of the results
may lead to wrong conclusions. If a digital camera is to be used, it should at least be
mounted on a tripod and adjusted parallel to the slide. It may also be difficult to provide
homogenous lighting in such a setup.

2.2 Data Acquisition
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2.2.1 General Overview (rapifleX MALDI Tissuetyper)

From a mass spectrometric point of view, an imaging experiment can be seen as a series
of measurements at defined positions on the sample. After a new imaging run has been
set up and measurement regions have been defined, flexImaging triggers the automatic
acquisition of spectra for each individual raster position. The interaction between
flexImaging and flexControl has been streamlined and simplified in comparison to earlier
versions of the software.

Figure 2-17 Simplified workflow for MALDI Imaging data acquisition on the rapifleX
MALDI Tissuetyper
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1. Setting up an imaging run is guided by a wizard, which will appear automatically when
you open flexImaging.

Alternatively, you can start the wizard by selecting File > New Imaging Run.

2. The individual entry fields of the wizard are mostly self-explanatory. On the first page
(Data Storage), enter a name for your imaging run and identify the folder in which all
information and data for the run will be saved.

o If you select the Create Subdirectory for Run check box, flexImaging will create
a subfolder with the run’s name in the Result Directory and store all files of the run
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there. This is the recommended and the default setting.

3. On the second page (Acquisition Settings), select the desired Raster Width ("pixel
size") for your measurement regions and select the flexControl acquisition method that
will be used for spectra acquisition at each individual raster position of this run.

o Spot Microarray and Tissue Profiling are more specialized use-cases explained in
sections 2.2.6 and 2.2.7.

o Several default methods are provided; see Table 2-2 for more information.

4. On the third page (Processing Options), the options for the on-the-fly processing of the
acquired data are selected.
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Selecting reasonable settings here is extremely important, as they are applied to the
spectra during acquisition. As a result, processed data will be available immediately
after the acquisition is complete. Reprocessing of acquired data after acquisition is
possible, but very time consuming.

Most importantly, flexImaging combines all individual spectra of an imaging run into
one large file, the so-called DAT file. During this process, the original data points of
each mass spectrum are down-sampled to a lower density and also re-binned onto a
linearm/z-axis. The recommended setting (which will be suggested by default) is 80%
of the original spectrum size. Lower values are possible, and will result in smaller, more
manageable DAT files, but also in potentially reducedMS resolution. Larger values are
not recommended, as thismay cause problemswhen converting the TOFm/z-axis into
a linear one. In general, we recommended changing the original Sample Rate in
flexControl if a different spectrum size is desired.

Smoothing and baseline subtraction are optional and recommended for linear mode
measurements and reflector mode measurements with larger mass ranges (> 1500
m/z). For reflector mode measurements at lower mass range, smoothing and baseline
subtraction are usually not required.

5. On page four (Sample Image), the previously acquired sample image must be
selected.

For instructions on how to acquire a suitable sample image, see section 2.1.7. The
sample carrier with the sample should now be loaded into the instrument. Be sure to
remember the position of your teach marks or reference points or transfer them to a
target lid as described previously (see section 2.1.2).
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6. On page five (Teach Sample), perform the teaching as instructed.

You can use the Zoom button tomagnify the sample image for easier positioning of the
teach points. Once teaching is complete, finish the run setup. You can then define one
or more rectangular and/or polygonal measurement regions by using the respective
command from theEditmenu.

When drawing a polygon region, you can delete the last point by pressing the delete
key. An entire measurement region can be modified by right-clicking on the respective
entry in theRegionswindow of the user interface. You can edit the shape of the region
or the raster width by selecting the respective command. All selected Raster widths
should bemultiples of each other (for example, 10 µm, 20 µm and 40 µm but not 10 µm,
20 µm and 30 µm in one run).

To select a different flexControl Method for all measurement regions, right- click
anywhere in the Imaging Display window and select Imaging Run Properties. The
acquisition method selected during setup can be changed on the Current Imaging
Run Parameters tab.

IMPORTANT When using the simplified workflow for fast imaging acquisition on the
rapifleX MALDI Tissuetyper, all measurement regions of a particular
runmust be acquired using the same flexControl method.
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A fast way to acquire separate datasets with different acquisition methods from the
same sample is to select the Save Imaging Run As option from the File menu and
save the run under a different name. This will allow a different flexControl method to be
assigned (as described above) but reuse the teaching and preferences from the
original run. The results would be saved as two completely independent datasets.

After all selections are final, the run can be started by selecting File > Start
autoXecute Run or by clicking the corresponding button in the toolbar. Alternatively,
use the Save autoXecute Sequence As option to save the run for latter acquisition in
batchmode. In either case, theRun Optionswindow will be displayed.

7. In most cases, the default settings can simply be accepted without change by clicking
OK and proceeding directly to acquire data.

Positioning Options

These dialog boxes can be used to offset the actual position from which spectra will be
acquired by a set distance from the center of each spot as defined by the teaching. This
is particularly useful if several measurements are to be conducted on a single sample
and if the raster width is substantially larger than scan size (see the following section on
flexControl methods).
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Eject Target After Acquisition

If this check box is selected, the sample carrier will automatically be ejected from the
source when the acquisition terminates. This is a useful setting when working with
volatile matrices that sublimate quickly in the source vacuum. When setting up a series
of runs for acquisition in batch mode, do not use this option as flexImaging is not able to
dock the sample carrier after it has been automatically ejected.

Measurement Order

The default measurement order for an imaging run is to acquire spectra row by row,
from left to right and from top to bottom, for each individually defined measurement
region. This is the only measurement order supported for fast acquisition on the
rapifleX MALDI Tissuetyper. The advanced options lead to substantially longer
acquisition times and are only recommended for special cases when a randomized
acquisition order is desired (for example when time-dependent effects are expected for
very long runs).

The Random Rows option will still acquire spectra in rows from left to right, but will
move to a random uncompleted row at the end of each row. If Random Spots is
selected, the acquisition order will be entirely random, with each spot position being
measured once. This requires substantial mechanical movement of the sample stage
and increases acquisition time.

Incremental Run

The default setting is to acquire data from all positions as defined by the measurement
order. The alternate option is not recommended on the rapifleX MALDI tissuetyper as it
is not compatible with fast image acquisition. If a quick overview of the sample is
required, we recommend increasing the raster width combined with an offset selected
under positioning options.

2.2.1.1 Selecting a flexControl Method

flexControl 3.8 contains a set of predefined acquisition methods that represent good
starting points for common MALDI imaging applications. Two parameters should always
be checked before each run and adjusted if necessary:
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Laser Power

Laser power can be modified using the slider next to the camera picture in the flexControl
user interface. When adjusting laser power, start from a relatively low value and increase
slowly while observing the signal intensity obtained for a spectrum acquired from the
sample.

Typically, signal intensity increases steeply after a certain threshold of laser power is
exceeded. Signal intensity can vary widely depending on sample type and preparation
method. As a rough guideline, try to achieve between 500 and 5000 intensity (per 100
shots) for the most intense peaks of a spectrum. Do not increase laser power more than
necessary as this will contribute to source contamination, increase noise, cause possible
fragmentation of ions, andmay even damage the sample tissue.

Detector Gain

Increasing detector gain can help to increase overall signal intensity. The Detector Gain
slider on theDetection tab of the flexControl user interface allows a maximum increase of
700 V for the detector voltage (setting 100×).

Try modifying the setting in small (50–100 V) steps and observe the effect on individual
spectra acquired from the sample. Low detector gain will lead to a loss in signal intensity
and sensitivity. If detector gain is too high, the results are broadening of peaks, loss of
resolution, and increased noise. High detector gain settings also contribute to detector
aging. If in doubt, use the lowest setting that still provides good spectra quality.

Make sure to save the flexControl method if any changes are made. If you decide to save
the method under a different name, remember that you may have to update the selected
acquisitionmethod for an imaging run you set up previously.
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Table 2-2 Default methods for MALDI imaging on rapifleX MALDI Tissuetyper

Method
name Polarity Smartbeam

Parameter

Scan
Size
(µm)

Recommend
raster width

(µm)
Shots Mass

Range

Sampling
Rate
(GS/s)

Linear acquisition mode
Imaging_
Proteinsa Positive M5 30 ×

30 100–150 800 2000–
20,000 0.31

Reflector acquisition mode

Imaging_
Lipidsb

Positive
or

negative
Single 10 ×

10 10–20 200 600–
1200 1.25

Imaging_
Peptidesc Positive Single 50 ×

50 50–80 800 600–
3200 0.63

Imaging_
Peptides_
highd

Positive Single 50 ×
50 50–80 800 600–

5000 0.63

Imaging_
Small_
Moleculese

Positive
or

negative
Single 50 ×

50 50–80 1000 100–
700 1.25

aThe standard method for analysis of intact small proteins from tissue that has been washed to remove
interfering lipids and coated with Sinapinic Acid or CHCA matrix. Preparation is usually relatively wet to
allow good extraction. This causes delocalization to some extent and therefore relatively large raster
widths are suggested.
bThese are standard methods for lipid analysis from tissue that has not been washed and has been
coated with DHB or HCCA matrix using a very dry deposition method, such as sublimation.
Delocalization is often minimal and signal strength is very high, allowing small raster sizes. Lipids can
be analyzed in both positive and negative mode using similar matrix preparations.
cThis is the standard method for analysis of endogenous or tryptic peptides from tissue after following
the respective sample preparation protocols. The mass range is limited to 3200 to allow use of the full
laser frequency of 10 kHz.
dIn this method the laser frequency is lowered to 5 kHz for detection of peptides with m/z >3200.
eSample preparation and method settings for small molecule imaging vary widely and are highly
dependent on the compound of interest. Typically, sensitivity is favored over spatial resolution and
therefore these methods favor larger raster sizes. These methods should be considered as starting
points for further method optimization.
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2.2.1.2 Guidelines for optimizing flexControl method settings for
MALDI Imaging

Advanced users are encouraged to modify the default methods according to their specific
requirements or for less common applications. The following guidelines serve as a starting
point for suchmodifications.

Acquisition mode

Selecting this instrument parameter is largely dependent on analytical requirements.
Generally, operation in reflector mode provides better resolution and mass accuracy at
m/z values below ~5,000. For higher m/z values and large mass ranges, operation in
linear mode is usually preferred. Because of longer flight times, reflector mode methods
generate larger spectra for the same mass range than linear mode spectra. Keep this in
mind when considering the total file size of your imaging datasets.

Polarity

The polarity of ions detected depends both on the analytes in question and the type of
matrix and possible additives (such as TFA) used during sample preparation. Many
peptides and proteins (in particular tryptic peptides) generate mostly positively charged
ions and are therefore analyzed in positive polarity mode. Lipids are often analyzed in
either polarity mode, because different subclasses of lipids may generate either positively
or negatively charged ions.

Smartbeam parameter, Scan size, Raster width, and Shots

These parameters are all interdependent and of particular importance for the quality of a
MALDI Imaging dataset.

In principle, the smartbeam 3D laser of the rapifleX MALDI Tissuetyper generates a
single, highly focused laser spot of <5 µm diameter (Smartbeam Parameter setting
Single). This laser spot irradiates the sample at the position indicated by the crosshairs
displayed in the camera picture in flexControl.
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Figure 2-18 smartbeam 3D laser parameters in flexControl

When Beam Scan is not selected, a single ~5 µm diameter spot is projected at the center
of the crosshairs. IfBeam Scan is activated (which is the default), the same spot is moved
across a user-defined rectangular sample area (Scan Size X × Y) in zig-zag mode if the
shot number is sufficient (see Figure 2-19). This means that the laser spot can be moved
quickly and precisely across the sample.

The number of individual laser pulses for this rectangle is defined in the Shots dialog box.
These shots will be summed up to generate a single mass spectrum from the rectangular
sample area. Typically, the number of shots and the size of the rectangle should be
matched to allow ablation of the entire area.

Larger Scan Size settings require more shots to cover the area. If the shot number is low
compared to the area, the laser will automatically switch to a semi-random movement
pattern. This is not recommended for MALDI imaging acquisitionmethods.

flexImaging 5.0 Workflows Manual Revision D Page 43 of 152



2 Workflows in Detail Bruker

Figure 2-19 Beam Scan operation with Smartbeam parameter Single

For large Scan sizes (>100 µm) the number of shots required can lead to long
measurement times. To compensate for this, the smartbeam 3D laser offers a second
smartbeam parameter referred to asM5 (see Figure 2-20).

When this parameter is selected, a modulator is inserted into the beam path that “splits”
the single focus spot to target five separate positions simultaneously. The pattern for these
five spots is fixed, but a beam scan can be applied to each spot in a similar way as
described above for a single spot. Data from the entire scan pattern is summed up to
generate a single spectrum for the central position. For imaging measurements, we
recommend keeping theScan Size below 35 µm to prevent the individual scan areas from
partially overlapping.
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Figure 2-20 Schematic representation of the ablation pattern for the M5 smartbeam
parameter setting with beam scanning activated

TheRaster Width parameter (selected by the user in flexImaging) represents the center-
to- center distance between two neighboring measurement positions (pixels). Raster
Width and Scan Size are closely related and should be set in a way that Raster Width ≥
Scan Size. This will prevent the area scanned for two adjacent sample positions from
overlapping. For theM5 pattern,Raster Width should be at leastScan Size + 70 µm.

Take into account the following whenmodifying the laser settings of a default method:

l Raster Width and Scan Size limit spatial resolution. A small raster width is
necessary to acquire high-resolution MALDI Imaging data. However, small scan
areas result in small amounts of sample being ablated for each individual spectrum.
Depending on the abundance of analytes and the quality of the sample preparation,
the ion yield of a small scan area might be insufficient to generate useful spectra. If
spectra quality appears to be low, consider increasing the scan size to accumulate
ions from a larger sample area.

l Measurement area and raster width regulate the number of spectra in a dataset.
Not every sample may require large measurement regions and a small raster width
to achieve good data. Acquiring large data sets costs instrument time, data storage
space, and ultimately contributes to laser and detector aging.

l Try to keep the number of laser shots per position at a reasonable but low value.
Once the sample is completely ablated, additional laser shots just contribute noise,
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increase measurement time, and reduce laser lifetime. You can evaluate the
number of shots required by manually acquiring spectra from a fixed sample
position in 100 shot increments to see how many shots ablate the sample fully.

Mass Range

The mass range selected for acquisition is largely governed by the experimental design of
a study. From a technical point of view, mass range should be kept as narrow as possible.
Most sample preparation protocols allow detection of molecules only in a relatively narrow,
definedmass range. Increasing themass range of themethod further will increase spectra
size without generating additional information. High m/z values require the measurement
of long flight times, in particular in reflector mode. When flight time approaches the
reciprocal value of the laser frequency, the laser frequency (and as a result, acquisition
speed) must be reduced to prevent interference between ions from subsequent laser
shots.

Sampling Rate

Sampling rate defines the time difference between two successive detector events. For
example, a sampling rate of 1GS/s (1 GigaSample per second) indicates 109 detection
events in one second, or one event every nanosecond. Sampling rate limits the maximum
resolution of a mass spectrum, because it limits the minimum flight time difference
between two ions that can be recorded. For each detector event, the corresponding
intensity value must be recorded. Low sampling rates can lead to loss of mass resolution
and mass accuracy and erroneous signal intensity. High sampling rates generate “long”
spectra with many individual data points which require a lot of storage space and lead to
longer acquisition and processing times. For individual spectra, spectrum size is not an
issue, but as imaging datasets typically consist of many thousands of spectra, it is
important to keep the size of individual spectra low in order to keep the entire dataset to a
manageable size.

When selecting a sampling rate, keep in mind that although the rapifleX MALDI
Tissuetyper provides high mass resolution on standard samples (for example, calibration
standard on a regular target plate), the irregular topography of typical imaging samples
leads to a loss of resolution. Selecting medium sampling rates (0.31–1.25 GS/s) does not
normally lead to a significant loss of data quality, but keeps total dataset size at a
manageable level. As a simple guideline, try to keep spectrum size (listed in flexControl) at
30,000 or below.
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2.2.1.3 MS/MS Experiments on rapifleX TOF/TOF

MALDI imaging experiments aimed at detecting a particular molecule of interest in a
targeted fashion often lack specificity when conducted on a MALDI-TOF instrument in MS
mode. This is due to the presence of other molecules of (almost) identicalm/z-values that
cannot be clearly distinguished using the resolving power and mass accuracy provided by
aMALDI-TOF instrument.

As an alternative to employing a high-resolution instrument such as the solariX FT-ICR or
optimizing sample preparation to remove interfering background ions, MALDI imaging
experiments in MS/MSmode can help to increase the specificity of detection.

The strategy of MS/MS imaging experiments is to isolate and fragment all ions in a narrow
m/z-range surrounding the target compound. Although all ions (target and background)
within that window will be subject to fragmentation, their fragmentation patterns are
different, and the detection of target-specific fragment ions serves as a specific indicator of
the target compound’s presence. Background ions of similar precursor mass may be also
be fragmented, but if they yield a different set of fragments their presences does not
interfere with detection of the compound on theMS/MS level.

The first step for a MS/MS imaging experiment is to set up an optimized flexControl
MS/MS method (file extension *.lft) that allows a distinct fragmentation pattern of the
target compound to bemeasured. Initial experiments can be conducted by spotting a stock
solution of the target compound on a regular MALDI plate and using the default flexControl
method “MSMS_Standard.lft” as a starting point.

In addition to the settings defined in the flexControl method, sample preparation
parameters— such as choice of matrix and solvent — play an important role in optimizing
the detection of a particular compound. For more information, see sections 2.1.4 and
2.1.5.

MS/MS imaging experiments are limited to compounds for which a distinct fragmentation
pattern can be established. Typically, these are low-molecular–weight compounds, such
as drugs or endogenousmetabolites.

After an MS/MS flexControl method has been established, make sure that you save it
under a suitable name. Setting up the MS/MS imaging run is similar to the workflow
described in section 1 and can be done using the same wizard with the following
exceptions:

l In step 3, on the second page of the wizard, make sure that you select the previously
optimitzedMS/MSmethod (file extension *.lft).
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Figure 2-21 Selecting the *.lft MS/MS method in the New Imaging Run Wizard

l If you selected an MS/MS method, you will be prompted to enter the mass of the
target compound precursor ion on the third page of the wizard. This value is not
automatically transmitted from the flexControl method settings and must be entered
manually. We recommended using baseline subtraction and smoothing.
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Figure 2-22 Entering the parent mass of the target compound

l The parent mass can be changed later by selecting Edit > Imaging Run
Properties and entering a different value.

Note SRM-type measurements are not supported on rapifleX instruments and no
Fragment Mass value should be entered.

2.2.1.4 Batch Runs — Multiple Samples on the Same Sample
Carrier

Theoretically, all samples on a sample carrier could be acquired as separate
measurement regions of a single imaging run using an optical image covering the entire
area. This is most often inconvenient both from a technical and an analytical point of view,
especially if the samples are from unrelated studies. All results of a particular imaging run
will always be scaled according to the highest intensity for each mass (across all
measurement regions). The result would predominantly reflect the relative intensity
differences between the regions, rather than the distribution of the selected masses in the
individual regions. If this is desired, for example in a diffential comparison between a
treated sample and a control, it is still better to measure these samples individually and
then utilize the use absolute intensity option for themass filters in question.
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To acquire multiple imaging runs sequentially, flexImaging provides a tool called
autoXecute Batch Runner, which can be found under All Programs > Bruker in the
WindowsStartmenu.

Instead of starting imaging runs directly out of flexImaging, save all runs of a batch using
the Save autoXecute Sequence As option from the File menu of flexImaging (or the
respective button from the toolbar). flexImaging will save the autoXecute sequence and
the according geometry in the default folders (usually D:\methods\AutoXSequences and
D:\methods\GeometryFiles). The suggested default name of files is the name of the
imaging run, preceded by Imaging_. Repeat this procedure for all runs that are part of the
batch.

If you are acquiring data from samples that are in the same optical image, remember that
you can reuse the teaching of a particular sample image by using the Save Imaging Run
As option from the Filemenu to save the run under a different name. You can then simply
deletemeasurement regions and define different ones for a second imaging run.

When all imaging runs of the desired batch run have been saved as autoXecute
Sequences, start the autoXecute Batch Runner.

Figure 2-23 autoXecute Batch Runner

The Add button will automatically open the default save location for autoXecute runs
(typically D:\Methods\AutoXSequences). Select all imaging runs of the current batch, from
the first to the last, and add them to the list. If you accidentally make a wrong selection,
remove it from the list usingDelete.
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If the Eject Target after Run check box is selected, the sample carrier will automatically
be ejected from the source after the last run of the batch terminates. When the selection is
complete, click Start to automatically acquire data from all imaging runs selected. The
flexImaging user interface is not required for these runs.

Note The incremental run option is incompatible with batch runs.

If the batch runner is closed using the Exit button, the measurement will stop after the
currently active autoXecute run has been finished.

To terminate the acquisition of an imaging run in progress, click theAbort automatic run
button in the autoXecute tab of flexControl (flex Series instruments) or the Stop button in
ftmsControl (FTMS instruments). Note that the measurement will proceed to the next run
of a batch if the batch runner is still open.

After the batch run is finished, the autoXecute sequences and geometry files for the runs
are no longer needed and can be deleted.

2.2.2 General Overview (flex Series Instruments)

From themass spectrometric side of view, the imaging experiment can be seen as a series
of measurements at defined positions on the sample. After creating a new imaging run in
flexImaging and definition of measurement areas, flexImaging triggers an automatic
measurement of the spectra.
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Figure 2-24 Workflow for an automatic acquisition of a MALDI image
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The following is a detailed description of an automatic imaging run that is triggered by

clickingStart autoXecute Run ( ):

l flexImaging creates a geometry for the sample. This geometry defines from which
x,y-points on the sample surface spectra will be acquired.

l flexImaging creates an autoXecute run. This run contains the geometry and defines
the order of measurements. It also contains the autoXecute method (as defined in
the Regions Pane in flexImaging).

l The autoXecute method contains the information on how each spectrum is
measured, such as how many laser shots are summed up, which laser energy is
used, if and how the laser moves during the acquisition. It also contains a reference
to the flexAnalysis method that is used for data processing. Optionally, it is possible
to define a flexControl method that is used for the acquisition.

l The spectra are measured according to the autoXecute method, saved, and then
sent to flexAnalysis, where they are processed with the flexAnalysis method that
was selected in the autoXecutemethod.

l After the automatic measurement is finished flexImaging reads either the raw
spectra, processed spectra, or peak lists, depending on the settings in the imaging
run properties.

It is recommended to define a smoothing and baseline subtraction in the flexAnalysis
method and to read the processed spectra (see data processing). The option “read peak
lists” is not recommended and mainly present for downward compatibility reasons. It is
therefore useful to not do a peak picking in flexAnalysis to save time in the processing.

Setting up the flexControl method

Start with a suitable linear method, such as LP_ Imaging_2- 20_kDa.par. It may be
necessary to adjust the mass range and the matrix suppression for the actual tissue
sample. Very likely a higher laser energy is necessary. It is also useful to restrict the
sampling rate to 0.1 or 0.5 GS/s. This makes the spectra file size smaller and the
processing in flexAnalysis and flexImaging faster.
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Figure 2-25 Adjusting the sample rate in Detection tab in flexControl

It is now time to fine tune the flexControl method. To do so, enableMove Sample Carrier

( ) in flexImaging and move the sample carrier to a spot on the tissue by clicking on that
spot in flexImaging's Imaging Display. Now adjust the laser energy in flexControl by
measuring some spots on the tissue. The mass range for the acquisition and the matrix
suppression should also be adjusted in flexControl, first parameter in detection tab,
second in spectrometer tab. In the autoXecute method used for the imaging run, it is
recommended to set the flexControl method to “none” (see figure) and the laser power to
“from laser attenuator” in the laser tab. If these settings are used, then the acquisition will
start with the current flexControl settings.
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Figure 2-26 One AutoXecute method setting: flexControl method is set to none

It is important to save the flexControl method directly before the run!

After the automatic run flexControl will reload the current flexControl method, and by doing
so will undo any settings that have been done after the last save of the method. It is
therefore recommended to save the flexControl method directly before starting the
automatic run.

Note It is mandatory to save the flexControl method directly before starting the
acquisition if the batch runner is used or if an incremental run is to be done!
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2.2.3 General Overview (FTMS Instruments)

This section applies to solariX instruments running with ftmsControl.

The FTMS imaging experiment is performed using flexImaging and ftmsControl. The
ftmsControl software allows for direct communication between flexImaging and
ftmsControl. Similar to TOF instruments, the FTMS imaging experiment is setup as a
series of measurements at defined x-y-positions of the sample. flexImaging is used to
create a new imaging run and to define the measurement area. Teaching and setting up
Imaging runs is done in a similar way as for the TOF instruments. Within the setup
procedure you will be asked to provide an MS method (see Figure 2-27), which must be
generated prior to the imaging set-up using ftmsControl. For the details to set-up the
ftmsControl method please refer to the respective ftmsControl manual.

Useful settings for the MS method are the online-recalibration and the data reduction
(recommended setting 0.975).

Figure 2-27 flexImaging dialogue for defining the ftmsControl Acquisition Method
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From the mass spectrometric point of view, the imaging experiment can be seen as a
series of measurements at defined positions on the sample. After creating a new imaging
run in flexImaging and definition of measurement areas, flexImaging triggers an automatic
measurement of the spectra.

Figure 2-28 Workflow in an automatic acquisition of a MALDI image using an
FTMS instrument
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What happens in detail when the automatic imaging run is started using Start

autoXecute Run ( ) is the following:

l flexImaging creates a geometry for the sample. This geometry contains the
information on which points on the sample the spectra will be acquired.

l flexImaging creates an autoXecute run. This run contains the geometry and defines
the order of the measurements. It also contains the ftmsControl method (as defined
in the Regions Pane in flexImaging).

l The ftmsControl method contains the information how the spectra are measured;
such as how many laser shots are summed up, which laser energy is used, and if
and how the target moves during the acquisition.

l The spectra are measured according to the ftmsControl method, saved and then
pushed into flexImaging.

Figure 2-29 Adjusting the MALDI parameters in ftmsControl

It is now time to fine tune the ftmsControl method. To do so, enable Move Sample

Carrier ( ) in flexImaging andmove the sample carrier to a spot on the tissue by clicking
on that spot in flexImaging's Imaging Display. Now adjust the laser energy in ftmsControl
by measuring some spots on the tissue. If available calibrate now on known peaks. You
can also choose to do an online calibration of the spectra (see the ftmsControl User
Manual for details).
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For highly accurate data it is important to save the calibrated ftmsControl method directly
before the run!

2.2.4 Incremental Runs

The acquisition of MALDI images can take quite a long time, especially if a small raster
width value is selected. To get a faster overview of the expected result without
jeopardizing the possibility of getting a high resolution image, flexImaging offers the option

of performing incremental runs. After pressing in flexImaging, the autoXecute Run
Options dialog opens. Here an incremental run can be selected. Spectra will be skipped
in the x- and y-direction (for example, selecting n = 4 will acquire every fourth spectrum in
the x- and y-direction, reducing the number of total spectra by a factor of 16). After this
initial part of the run, the result can be evaluated (e.g. if the quality of the spectra is

sufficient) and then the remaining positions can be acquired by pressing again. It is
necessary to save the imaging run if the remaining positions are to be acquired later,
otherwise flexImaging will not remember the incremental status of the run.

2.2.5 Arbitrary Arrays

The arbitrary arrays workflow requires a homogenous matrix layer on the tissue, e.g. from
a spray coating. In this workflow the raster positions in a measurement region can be
arbitrarily defined. The settings for the automatic measurements can differ depending on
the raster width and the laser spot diameter. This applies especially to the laser movement
and the number of laser shots to be summed up.

Figure 2-30 Schematic of an arbitrary array on a tissue section
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Laser is firing in the center of the spot

The simplest approach is to acquire one spectrum with a defined number of laser shots
from the center of each raster position.

Figure 2-31 Acquiring one spectrum from the center of each raster position

This will happen if no laser movement is specified in the autoXecute method (flex Series
instruments) or no stage movement is specified in the ftmsControl method
(FTMS instruments) for the data acquisition.

2.2.5.1 Arbitrary Arrays on flex Series Instruments

With the flexImaging installation example, methodswith this behavior will be installed:

l for flexControl 3.4 the name of themethod is "Imaging_FC33_noraster.axe"
l for flexControl 3.3 the name of themethod is "Imaging_FC33_noraster.axe"
l for flexControl 3.0 the name of themethod is "Imaging_FC30_noraster.axe"
l for flexControl 2.4 the name of method is accordingly "Imaging_ FC24_
noraster.axe".

The number of laser shots that can be acquired from one position on the sample is limited
by thematrix layer. For a typical preparation with a standard imagePrep protocol, 200–400
laser shots per raster position is a reasonable number.

Laser is walking around the center of one spot

If the raster width in the imaging region is larger than the laser spot (always if the
raster width is larger than 100 µm) diameter, it is obvious that only a small part of the actual
area of each raster position gets measured. It is therefore sometimes desirable to move
the laser within each sample position.

Depending on the flexControl version, two different ways of acquisition are recommended:

In flexControl 3.x, it is recommended to activate the random walk feature on the sample
position while acquiring the spectrum.

Page 60 of 152 flexImaging 5.0 Workflows Manual Revision D



Bruker 2 Workflows in Detail

Figure 2-32 Random walk of laser during acquisition

With flexImaging, an autoXecute method “Imaging_FC30_randomwalk” (for flexControl
3.0) or “Imaging_FC33_randomwalk” (for flexControl 3.3) is installed that shows this
behavior.

flexImaging will calculate the diameter of the sample spots from the raster width and the
laser diameter as specified using Preferences - User Interface Defaults. It is therefore
important to specify the correct laser diameter in preferences.

In flexControl 2.4, no random laser walk is available. It is recommended, to have the
laser move in a "five-on-a-dice" pattern.

Figure 2-33 "Five-on-a-dice" laser movement during data acquisition

With flexImaging, an autoXecute method "Imaging_FC24_raster5" is installed that shows
this behavior.

flexImaging will calculate the diameter of the sample spots from the raster width and the
laser diameter as specified using Preferences - User Interface Defaults. It is therefore
important to specify the correct laser diameter in preferences.

2.2.5.2 Arbitrary Arrays on FTMS Instruments

The number of laser shots that can be acquired from one position on the sample is limited
by thematrix layer; usually not more than 400 shots can be obtained.

Laser is walking around the center of one spot

If the raster width in the imaging region is larger than the laser spot (always if the raster
width is larger than 100 µm) diameter, it is obvious that only a small part of the actual area
of each raster position gets measured. It is therefore sometimes desirable to move the
laser on each sample position. If the laser would move on one imaging sample position, it
is also possible to level out effects of small scale inhomogeneity in thematrix layer.

flexImaging 5.0 Workflows Manual Revision D Page 61 of 152



2 Workflows in Detail Bruker

In ftmsControl one can set the MALDI stage doing a smart walk on the sample position
while acquiring the spectrum. However, this will slow down the overall acquisition.

Figure 2-34 Smart walk of laser during acquisition and parameters

Tip For a non-synchronized but faster movement, choose the randomwalk option.

2.2.6 Spot Microarrays

A spot microarray is a regular grid of small matrix droplets deposited on the sample. Spot
microarrays can be prepared with amatrix spotting robot.

Figure 2-35 Spot microarray on tissue
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During the preparation of a spot microarray, diffusion will cause delocalization of analytes
within each droplet. The spatial resolution of a microarray preparation is therefore limited
by the droplet diameter. One mass spectrum will be acquired from each droplet (“pixel”).
The optical image selected in the New Imaging Run Wizard (= sample image) must be
an image of the sample with the matrix droplets already deposited, because these will be
used as a reference for determining the acquisition spots.

Data acquisition

Because the dried droplet preparations usually allow a higher number of laser shots per
position than spray preparations, it is recommended to take advantage of that. To average
out local inhomogeneity in the preparation of each spot, it is also recommended to have
the laser moving on each spot during the acquisition.

For FTMS instruments, the best way to do this is using the smart walk or the random walk
of ftmsControl.

For flex Series instruments, the best way to do this is dependent on the used flexControl
version. flexImaging installs example autoXecutemethods for both flexControl versions.

With flexControl 3.x , it is recommended to have the laser perform a “random walk”
during the acquisition. The autoXecute method “imaging_ FC30_DriedDroplet” (for
flexControl 3.0) or “imaging_FC33_DriedDroplet” (for flexControl 3.3 and 3.4) shows
this behavior.

In flexControl 2.4, the random walk feature is not available. Here it is recommended to
use the “hexagon” moving pattern of the laser. This movement covers the entire matrix
droplet. The autoXecutemethod “imaging_FC24_DriedDroplet” shows thismovement.

For the rapifleX MALDI Tissuetyper instrument and flexControl 4.0 we recommended
activating the Movement on Sample Spot option on the Sample Carrier tab in
flexControl and selecting Smart – Complete Sample and the limiting the diameter to the
actual diameter of thematrix droplet in the respective dialog box.

Setting up the run

Setting up a spot microarray run in flexImaging differs slightly if a spot list from the robot is
available or not. If no spot list is available then theNew Imaging Run Wizard asks for the
upper left, the upper right and the lower right spot as teach points. It is necessary to
provide either the number of spots in X- and Y- direction or the pitch in micrometers.
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If a spot list from the robot is available then it is not necessary to provide the number of
spots in X- and Y-direction or the distance. This information is taken from the robot file.

Starting the run

Before starting the run it is necessary to define a measurement region using either Add

Rectangular Measurement Region ( ) or Add Polygon Measurement Region (

). In the easiest case a rectangular area will be defined that contains all spots. Since
the tissuemay be not rectangular and there will be matrix spots without tissue underneath,
these spots can be excluded by defining a polygon region around the tissue.

It should be checked that the defined measurement positions do match with the matrix

spots. This can be done by switching on Laser Spots ( ).

Figure 2-36 Laser spot positions displayed to check teaching
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Displaying the results

We highly recommended acquiring an optical image of the sample before the matrix
spotting and co- registering this image using the Co-Register Image option of the
flexImaging Edit menu. This image can then be displayed using the Co-Registered
Image option from the Viewmenu, and the sample image can be deactivated. In this way,
superimpositions of MALDI data on a good quality sample image can be used for data
evaluation.

Figure 2-37 Imaging result display on
primary image with matrix
spots

Figure 2-38 Imaging result display on
co-registered image
(taken before spotting)

2.2.7 Tissue Profiling

Tissue profiling (also known as histology-directed acquisition) is a workflow that does not
acquire a full mass spectrometric image of the sample, but rather acquires profile spectra
from several spots of interest selected by the user. Such a selection can be based on
tissue morphology (as seen on the optical image or a stained serial section of the sample).
For each selected spot, onemass spectrumwill be acquired

In setting up the tissue profiling workflow, select Tissue Profiling in the New Imaging
Run Wizard. In this dialog, the spot diameter should be set correctly.
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In the tissue profiling workflow, it is not possible to use the region tools (Add Rectangular
measurement Region and Add Polygon Measurement Region ) to define a
measurement region in terms of a connected area. Instead it is necessary to define each

spot using Add Measurement Spot ( ) and set up measurement spot groups which
then represent ameasurement region.

Although it is possible to combine the Tissue Profiling workflow with a spray-coated
sample (for example, from the imagePrep), it can often be faster to spot matrix only within
the regions of interest. This can be done manually or with a robot. In this case, it is
advisable to acquire an image of the tissue section before and after matrix spotting. While
it is easier to define the measurement spots on an image taken after spotting,
interpretation of the results can be much easier if the matrix-free image is co-registered in
flexImaging.

In the following example the workflow is shown with a sagittal rat brain section with
manually spottedmatrix droplets.
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Figure 2-39 Rat brain section with matrix spots

In this example, two measurement spot groups will be defined. In the tissue profiling
workflow, spots belonging to the same measurement spot group do not have to be
interconnected. Instead, they can be freely defined by the user. Typically, one
measurement spot group will includemultiple similar tissue features present in the sample,
such as several scattered carcinoma in situ within one section. If different tissue types are
each assigned to one measurement spot group, the statistical comparison of these tissue
types can be performed in ClinProTools in a very straightforwardmanner.

In the rat brain section here, we want to define two measurement spot groups, the
cerebrum and the cerebellum. To do this, we first define a second measurement region
with a right mouse click in the Regions Pane:
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Figure 2-40 Defining a new measurement region

It is also helpful to give the regions a descriptive name, such as “cerebrum” and
“cerebellum” in this example. A spot can be added to a measurement region by usingAdd

Measurement Spot ( ). The spot will always be added to the currently active region.

Note: the spots are only visible if Measurement Regions ( ) is also checked. As long
as Add Measurement Spot is active, the spots will be shown in the color of their
respective region.
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Figure 2-41 Definition of measurement spots in tissue profiling workflow

From here the acquisition can be started as usual. A few considerations apply to the data
acquisition.
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autoXecute settings (flex Series instruments)

Usually from dried droplet preparations a lot more laser shots can be summed up
compared to spray preparations. It is therefore possible to increase the number of laser
shots in the autoXecute method substantially. To level out local inhomogeneity in the dried
droplet preparation, a laser movement should be selected which covers the entire size of
the matrix spot. In flexControl 2.4 it is recommended to use the “hexagon” movement
pattern, in flexControl 3.0 and higher it is recommended to select “randomwalk”.

ftmsControl settings (FTMS instruments)

Usually from dried droplet preparations a lot more laser shots can be summed up
compared to spray preparations. It is, therefore, possible to increase the number of laser
shots in the ftmsControl method substantially. To level out local inhomogeneity in the dried
droplet preparation, a stage movement should be selected which covers the entire size of
thematrix spot (adjust the smart walk parameters accordingly).

flexControl setting (rapifleX MALDI Tissuetyper)

Usually, a lot more laser shots can be summed up from dried droplet preparations
compared to spray preparations. For the rapifleX MALDI Tissuetyper instrument and
flexControl 4.0 we recommended activating the Movement on Sample Spot option on
the Sample Carrier tab in flexControl an selecting Smart – Complete Sample and the
limiting the diameter to the actual diameter of the matrix droplet in the respective dialogue
box.

Advanced tissue profiling – spot list import

If a robot was used to spot the matrix droplets, the spot coordinates can be imported in
flexImaging. After the imaging run was created in “tissue profiling” mode as usual, the spot
list can be imported using Import > Spot List . In the Spot List Import dialog a
representation of the spot distribution is shown, and a three point teaching is required to
align the spots. SeeSpot List Import Wizard for details.
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Advanced tissue profiling – spot list export

A tissue profiling setup may involve e.g. a third person, usually a pathologist, to define the
location of the measurement spots on a histologically stained reference section and
marking them in different colors according to their regions. It is possible to load the
unspotted sample in the instrument and set up a new imaging run in tissue profiling mode
in flexImaging. Next the image of the reference section with the defined spots can be co-
registered. These spots can be marked as measurement spots as described above. Now
the coordinates of the spots can be exported using Export > Spot List. The spot list and
the samples can now be transferred to a robot to prepare the selected spots. Some
manual adjustments of coordinate offsets are to be expected.

Result presentation

If the result is displayed with primary (spotted) optical image, the resultsmay not appear as
conclusive as they are (left figure). The image will look nicer in a presentation if the optical
image of the unspotted sample is co-registered and used for the display of the data (right
figure).
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Figure 2-42 Result display of a
selected mass filter with
primary image

Figure 2-43 Result display of a selected
mass filter on co-registered
(unspotted) image
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2.2.8 MS/MS Experiments

Note MS/MS experiments, including SRM, are not supported on the rapifleX MALDI
Tissuetyper instrument in TOF configuration.

MS/MS experiments in MALDI imaging are usually done to image the distribution of small
molecules such as drugs in tissues. Because in the low mass region of a MALDI spectrum
a lot of interfering signals from the matrix and other small molecules are observed, the
MS/MS experiments increase the selectivity by fragmenting a specific molecule, and then
generating the image on a fragment ion of that molecule. In contrast to other imaging
workflows, themass to bemeasured has to be known in advance.

For each pharmaceutical substance, it is usually necessary to evaluate the right matrix,
solvent and preparation conditions (see section 2.1.4).

Since flexImaging works with flexControl 2.4, 3.0 as well as with flexControl 3.3, three
different use- cases can be considered concerning MS/MS measurement. They are
explained in the topicsmentioned below.

It is recommended to use a special LIFT method for small molecules. These methods can
be set up on ultraflex/autoflex II and higher. If no such method (e.g. LIFT_small_mass.lft)
is found on your instrument, please contact your local service.

If you want to measure in the SRM mode, but no such a method (e.g. SRM.srm) is found
on your system, please contact your local service. If FAST measurements are possible on
your instrument, a FASTmethod can be converted to a SRMmethod.

2.2.8.1 flexImaging and MS/MS Measurement — "With Parent"

This section applies, if a “normal” LIFT acquisition should be done in automatic mode. This
consists of measuring the parent signal first, then switching into fragment mode. This
method may work in some cases, but in others it will not. The reason is that it is often not
possible to obtain a good signal for the precursor. If during the automatic measurement no
good signal for the parent is detected, then no fragments will be measured. How to
measure spectra directly in fragment mode is explained in the next section.

If the imaging sample should be measured with LIFT two differences in comparison with
the common imaging MS measurement have to be considered, independent if flexControl
2.4, 3.0 or 3.3 is used:
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l a LIFT parent mass has to be defined in flexImaging

l use a flexControl LIFT method for measurement

Follow the steps below to setup an Imaging LIFT run:

1. Set up a common Imaging run as for MSmeasurement.

2. Switch to flexControl and open the AutoXecute method Imaging_FC30_MSMS.axe
(for flexControl 3.0 or for flexControl 3.3) or Imaging_ FC24_ MSMS.axe (for
flexControl 2.4).

3. In the General tab of the AutoXecute Method Editor load the flexControl LIFT method
of choice.

Figure 2-44 AutoXecute Method Editor: Selection of a flexControl LIFT method

4. In the MS/MS tab deactivate the check box “Measure fragments only” (not in
flexControl 2.4).
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Figure 2-45 AutoXecute Method Editor: Deactivated "Measure fragments only"

5. Save themethod with a different name and close the AutoXecuteMethod Editor.

6. Switch back to flexImaging and select the new autoXecute method for all
measurement regions.

7. Open the Sequence Properties - Current Sequence Parameters dialog and enter
the parent mass you want to measure.
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Figure 2-46 Sequence Properties - Current Sequence Parameters dialog for entering
the parent mass

8. Start the run.
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2.2.8.2 flexImaging and MS/MS Measurement — "Fragments Only"

Sometimes it is needed to omit parent measurement and start the Imaging MS/MS directly
in the fragments mode. This is necessary if no good signal for the parent can be obtained.
Since this happens often in these kinds of experiments, it is the recommended way to
proceed.

“Fragments only” with flexControl 3.x

To start with measurement of fragments using flexControl 3.0 or flexControl 3.3 follow the
steps below:

1. Prepare the Imaging run in the sameway asMSmeasurement.

2. Switch to flexControl and open the AutoXecutemethod Imaging_FC30_MSMS.axe.

3. In the General tab of the AutoXecute Method Editor load your good working
flexControl LIFT method.

Figure 2-47 AutoXecute Method Editor: Selecting a flexControl LIFT method

4. In theMS/MS tab activate the check box “Measure fragments only".
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Figure 2-48 AutoXecute Method Editor: Activated "Measure fragments only"

5. Save themethod with a different name and close the editor.

6. Switch back to flexImaging and select the new autoXecute method for all
measurement regions.

7. Open the Sequence Properties - Current Sequence Parameters dialog and enter
the parent mass you want to measure with LIFT.
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Figure 2-49 Sequence Properties - Current Sequence Parameters dialog for entering
the parent mass

8. Start the run.
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Note In this workflow the one point recalibration on the parent mass upon switching
from parent to fragment mode is omitted, so the measured mass may show a
systematic deviation. This can be either compensated by measuring the pure
substance under same circumstances, to find the apparent masses of the
expected fragments, or by creating a new calibration entry in the LIFT method
with the parent and fragments of the compound in question and calibrating the
LIFT method. In this case it is recommended to save the LIFT method under a
new name first and then creating one special LIFT method for each compound
to bemeasured.

“Fragments only” with flexControl 2.4

To start with measurement of fragments using flexControl 2.4 a few more steps are
necessary. It is recommended to prepare the pure substance next to the tissue and apply
somematrix on it.

1. Prepare the Imaging run as known for commonMSmeasurement; especially choose a
MS AutoXecutemethod with an empty flexControl method entry.

2. Do not enter a parent mass in the Sequence Properties - Current Sequence
Parameters dialog, the field has to remain empty!!!

3. Switch to flexControl.

4. Open the AutoXecute method used for the measurement and make sure that NO
flexControl method is loaded in the General tab.

5. Load the flexControl LIFT method of choice in flexControl (not in the autoXecute
method!):

a. Switch to the LIFT tab

b. Type in the parent mass you want to measure with Imaging

c. Acquire the parent spectrum, either from the tissue itself or from the preparation
with the pure substance next to the tissue

d. Switch into the Fragmentsmode.

6. Switch back to flexImaging (without any further changes in flexControl) and start the
run.
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2.2.8.3 flexImaging and MS/MS Measurement — "SRM"

During the automatic SRMacquisition, only the defined fragment is acquired.

If the imaging sample should be measured with SRM three differences in comparison with
the common imagingMSmeasurement have to be considered:

l a parent mass has to be defined in flexImaging

l a fragment mass has to be defined in flexImaging

l use a flexControl SRMmethod for measurement

Follow the steps below to setup an Imaging SRM run:

1. Set up a common Imaging run as for MSmeasurement.

2. Switch to flexControl and open the AutoXecutemethod Imaging_FC3.3_SRM_.axe.

3. In the General tab of the AutoXecute Method Editor load your good working
flexControl SRMmethod.

Figure 2-50 AutoXecute Method Editor: Selection of a flexControl SRM method

4. Save themethod with a different name and close the AutoXecuteMethod Editor.

5. Switch back to flexImaging and select the new autoXecute method for all
measurement regions.

6. Open the Sequence Properties - Current Sequence Parameters dialog and enter the
parent mass and the fragment mass you want to measure.
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Figure 2-51 Sequence Properties - Current Sequence Parameters dialog for entering
the parent mass and the fragment mass

7. Start the run.
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2.3 Data Acquisition Using HyStar and ftmsControl

The FTMS imaging experiment is performed using FlexImaging, HyStar and ftmsControl.
Similar to TOF instruments, the FTMS imaging experiment is setup as a series of
measurements at defined x-y-positions of the sample. FlexImaging is used to create a new
imaging run and to define the measurement area. The autoXecute imaging run is then
sent to HyStar where the mass spectrometric method is added. HyStar then triggers
ftmsControl to measure the spectra.

Figure 2-52 FTMS workflow in an automatic acquisition of a MALDI image
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Starting the automatic imaging run by clicking Start autoXecute Run ( ) triggers the
following series of events:

l flexImaging creates a geometry for the sample. This geometry contains the
information on which points of the sample the spectra will be acquired.

l flexImaging creates an autoXecute run. This run contains the geometry and defines
the order of the measurements. It also contains the autoXecute method (as defined
in the Regions Pane in flexImaging).

l The autoXecute method is then sent to HyStar, where it is combined with the
ftmsControl method. Additionally, method parameters can be fine-tuned, such as
the laser power, the number of laser shots and the number of scans summed per
pixel.

l HyStar then triggers ftmsControl to measure the spectra according to the
autoXecutemethod.

l After the automatic measurement is finished flexImaging reads either the raw
spectra, the processed spectra or the peak lists, depending on the settings in the
imaging run properties.

For FTMS data it is recommended not to use the baseline subtraction option in the
flexAnalysis method and to read in the raw spectra (see data processing). This will save
time when loading spectra into flexAnalysis.

General steps in performing an FTMS imaging run

1. Setup data acquisitionmethod in ftmsControl.

2. Open the HyStar MALDI automationmodule.

3. Create a new imaging run in flexImaging.

4. Teach new sample image to motor positions using ftmsControl (via
HyStar/flexImaging).

5. Definemeasurement regions in flexImaging.

6. Send autoXecutemethod to HyStar.

7. Add ftmsControl method to autoXecutemethod.

8. Start automatic run fromHyStar.
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Setting up the ftmsControl method

The general ftmsControl MALDI method needs be fine-tuned for the specific tissue sample
to be imaged. To do so, first load the sample into the source. Using the displayed geometry
file, e.g. MTP 384 ground steel, move the sample carrier to a spot on the tissue. In Tune
mode, adjust the laser power to optimize signal intensity for several spots on the tissue.
Additional parameters such as mass range, Q1 mass and data set size are adjusted now.
Once the acquisition parameters are optimized, the entire data acquisition method is
saved.

Figure 2-53 Selecting saving entire method

HyStar MALDI automation module

Communication between flexImaging and ftmsControl is controlled via HyStar. For
imaging experiments, the “MALDI Automation” Acquisitionmodule is required.

Figure 2-54 Selecting MALDI Automation
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The MALDI Automation module is necessary for all communication between flexImaging
and ftmsControl. Specifically, it is responsible for communications during teaching of the
sample image and for running the autoXecute imaging run. HyStar does not have an
interactive role during teaching, but is required to be open when doing so.

The MALDI Automation module also combines the autoXecute imaging run with the
ftmsControl method. After choosing the MALDI Automation module select the "Imaging
workflow".

Figure 2-55 Selecting MALDI Imaging

The autoXecute imaging run is loaded automatically from flexImaging when the automatic
imaging run is started in flexImaging. To include the ftmsControl method, use the browse
button in theMethod Name column to select the correct method.

Figure 2-56 Method Name column

Typically, it is not necessary, but if required, several of the MALDI method parameters are
editable within HyStar. By default, the parameter columns are labeled with a “d” to indicate
that the value defined within the method will be used. If the user chooses, new values can
be added that will overwrite the values defined in themethod.
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Figure 2-57 HyStar Samples tab

Once the ftmsControl method is loaded, it is necessary to “click” out of the field. The Start
button is then active. The start button will begin a multi- fid acquisition in ftmsControl.
Within a single LC-type run, each position (sample) defined in the autoXecute imaging run
is run and written to an individual file. In HyStar, all of the positions are given as individual
entries in the Acquisitions Sample Table.

Figure 2-58 HyStar Acquisitions tab

Teaching

For the FTMS experiments, teaching is done following the same procedure as the TOF
experiment. The only difference being that ftmsControl (with HyStar in the background) is
used rather than flexControl.
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2.4.1 Histological Staining and Co-Registration of
Microscopic Images

Preparation of a histologically stained section

The analysis of MALDI imaging data from a tissue sample will often require the
comparison of the MALDI data with a histologically stained sample. Many staining
protocols, including the common hematoxylin & eosin (H&E) staining, are compatible with
MALDI imaging when performed on the same section after the MS data acquisition. The
remaining matrix is washed off the sample using ethanol, acetone, or another suitable
solvent and then a staining protocol, such as an H&E staining, is performed. The stained
section can be easily co-registered with the MALDI data in flexImaging and will allow the
precise interpretation of the results. (This technique has been described in: Crecelius AC,
Cornett DS, Caprioli RM, Williams B, Dawant BM, Bodenheimer B.; J Am Soc Mass
Spectrom. 2005 Jul;16(7):1093-9; and Schwamborn K, Krieg RC, Reska M, Jakse G,
Knuechel R,Wellmann A.; Int JMol Med. 2007 Aug;20(2):155-9.)

The choice of the staining protocol seems to be uncritical but some changes may be
observed. For H&E staining it will usually be necessary to increase the time for
hematoxylin and to decrease the time for eosin.
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If the tissue is not preserved sufficiently during the measurement or floats off the slide
during the staining, consider a polylysine treatment of the slides prior to the sample
preparation (see section 2.1.1).

A stained serial section can also be used, but this has the disadvantage that it is often not
possible to achieve a perfect alignment between the stained and the MALDI image.
Especially small features at higher resolutions can often not be aligned unambiguously.

A third possibility is the usage of MALDI imaging compatible stains to stain the image prior
to the measurement. This has the disadvantage that it subjects the sample to additional
handling prior to the measurement and that the MALDI compatible stains do not yield the
same depth of information as e.g. a H&E staining. (For a detailed description of MALDI
imaging compatible stains see: Chaurand P, Schwartz SA, Billheimer D, Xu BJ, Crecelius
A, Caprioli RM, Anal. Chem. (2004), 76(4): 1145-1155.)

Co-registration of microscopic images

FlexImaging supports different types of images for the co-registration:

Bitmap Images: Bitmap images will be loaded into the memory of the computer as a
whole. Since the MALDI data and the image have to share the same memory, this limits
the useful resolution of the bitmap image. However: flexImaging will keep the resolution of
the image for the display. While (depending on the size of the specimen) it will not be
possible to use a full microscopic resolution, it will still allow a detailed localization of
histological features.

Virtual slides: Virtual slides are files that are generated by dedicated microscopic slide
scanners. These slides contain the image data in different pre-processed resolutions. This
allows flexImaging to load only the part of the image that is needed into the memory.
Therefore the full microscopic resolution is available for large specimens, which allows a
detailed evaluation of the histology.

Supported virtual slide formats:

flexImaging 5.0 supports the following virtual slide formats:

l ZeissMIRAX (*.mrxs)

l 3D Histech Pannoramic (*.mrxs)

l Aperio *.svs files with jpg compression

l Additional formats may be included later with software patches. Please contact the
software support (maldi.sw.support@bruker.com) for information.
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Co-register the image of the stained tissue section

In the Edit > Co-Register Image dialog, browse to the MIRAX/Pannoramic image and
select the according *.mrxs file. Co-register the image by following the instruction in the
dialog window by defining three pairs of matching features on the primary image and the
image to be co-registered.

Using MIRAX or Pannoramic slides (*.mrxs files) for co-registered images

We recommended installing the version of the MIRAX/Pannoramic viewer that was used
during testing of flexImaging software on the computer that runs flexImaging. Installing this
version of the viewer will ensure compatibility with MIRAX and Pannoramic scanners. For
details, refer to the flexImaging release notes or contact MALDI software support.

Since the direction in which the slides are scanned is different in the slide scanner and in
the flex instrument, typically there is a 90° rotation between the virtual slide image and the
primary image in flexImaging. This does not matter for the co-registration. After the co-
registration flexImaging will rotate the virtual slide correctly.

There may be slight shifts in the positions on the virtual slide image if several non-
connected regions on the slide are scanned (e.g. the absolute positions of the teachmarks
may have small offsets compared to the tissue). In such a case it is best to use actual
features at the edge of the tissue piece for co-registration.

After co-registration of a *.mrxs image is complete, flexImaging asks if the image should be
copied into the flexImaging imaging run directory. This ensures that the entire data set
including the co-registered image can later be distributed conveniently. The *.mrxs file and
the entire directory with the image data will be copied.

The entire virtual slide data of a Zeiss/Pannoramic scan consists of the *.mrxs preview
image and a folder with the same name that contains the raw data.

Using Aperio *.svs files with jpeg compression

Only *.svs files with jpeg compression can be used in flexImaging. If the data is saved
differently or with a different compression, open the slide in the Aperio software and save it
as jpeg compressed *.svs file.

There may be slight shifts in the positions on the virtual slide image if several non-
connected regions on the slide are scanned (e.g. the absolute positions of the teach-marks
may have small offsets compared to the tissue). In such a case it is best to use actual
features at the edge of the tissue piece for co-registration.
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After co-registration of a *.svs image is complete, flexImaging asks if the image should be
copied into the flexImaging imaging run directory. This ensures that the entire data set
including the co-registered image can later be distributed conveniently.

Managing multiple co-registered images

Sometimes it may be useful to co- register different images, e.g. an H&E and an
immunostain. If an optical image gets co-registered in a data set that already contains a
co-registered image, the previous co-registration is kept. The Co-registered images
entry in the Viewmenu opens a list with the type and names of the co-registered images.
The currently displayed co-registered image can be selected here.

2.4.2 Data Processing in flexAnalysis and flexImaging

For the data processing there are two things to consider, the optional processing of
acquired spectra in flexAnalysis (which includes smoothing and baseline subtraction) and
the processing in flexImaging (which includes the data reduction and optional
normalization).

If in the Sequence Properties- Processing Options dialog the Read Raw Spectra
option is defined, then flexImaging can optionally be prompted to perform an internal
baseline subtraction. If the Read Processed Spectra option is defined, then flexImaging
will read the spectra as they are processed in flexAnalysis. For imaging data acquired in
reflector mode, it is usually sufficient to read the raw spectra, but performing a smoothing
and baseline subtraction in flexAnalysis is usually recommended when acquiring linear
mode spectra.

Data processing in flexAnalysis

This spectrum shows a typical mass spectrum from an imaging run before and after
processing in flexAnalysis. It is normal to have a high noise level towards the low mass end
of the spectrum and a rapidly declining baseline. The initial steep slope in the baseline
comes from thematrix suppression in flexControl, which was set to maximum gating in this
example: The rise in the baseline in the low mass area correlates with the detector being
switched on. It is obvious that the data processing in flexAnalysis (smoothing and baseline
subtraction) enables a better analysis of the imaging data.
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Figure 2-59 Spectrum from imaging run before and after processing in flexAnalysis

flexAnalysis method for smoothing and baseline subtraction

With the installation of flexImaging 2.0 some flexAnalysis methods for processing imaging
data will be installed. The method "Imaging_FA24_proteins.FAMSMethod" is for use with
flexAnalysis 2.4. It uses a convex hull baseline subtraction. The method "Imaging_FA30_
proteins.FAMSMethod" is for use with flexAnalysis 3.0. The method "Imaging_FA33_
Proteins.FAMSMethod" is installed for flexAnalysis 3.4 and 3.4. Here a top hat baseline
subtraction is used. In both cases a "Gaussian" smoothing is done.
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Figure 2-60 Parameters of "Imaging_FA30_proteins.FAMSMethod"

Thesemethodswill work with the typical mass range for protein imaging (e.g. 2 to 20 kDa).
If e.g. peptides in reflector mode are measured it will be necessary to adjust the smoothing
parameters in these methods. In such cases a smaller smoothing width is recommended.
Also the "Savitzky-Golay " smoothing may perform better with isotopically resolved
spectra.

The order of the processing should be first smoothing then baseline subtraction. These
actions are defined in the scripting part of the method. A detailed tutorial on flexAnalysis
scripting can be found in the flexAnalysis documentation. In most cases, however, it will be
sufficient to change the examplemethods according to specific needs.
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Figure 2-61 Script of "Imaging_FA30_proteins.FAMSMethod"

Processing in flexImaging

If flexImaging is set to Read Raw Spectra in the Sequence Properties - Processing
Options dialog it will perform a predefined baseline subtraction. If flexImaging is set to
Read Processed Spectra it will just read the processed data. (Note: if the spectra have
not been processed in flexAnalysis, this option will lead to loading the raw data without any
smoothing or baseline subtraction).

flexImaging usually loads the entire mass range, unless specified otherwise in the imaging
run properties and reduces the spectra to the specified number of data points. The number
of data points required should be tried out.
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2.4.3 Normalization

The aim of normalization is to remove variations in pixel-to-pixel intensity (or brightness).
These variations can be caused by uneven matrix deposition (more matrix leads to higher
spectrum intensity), ion suppression due to different salt or lipid content in certain areas, or
other factors that change the intensity of peaks in the mass spectra. Depending on the
number of random effects in the data set, normalization can lead to significant
improvement of the data. In some cases, normalization may be a prerequisite for viewing
all histological information.

Note Each normalization method is based on certain assumptions about the data
(see discussion below). In real data sets, only some — or in some cases none
— of these assumptions may be true. In such cases, normalization can
produce artifacts that can be mistaken for biological information. It is therefore
important to apply normalization with care.

Quantitative comparison of data sets using different normalization methods is not feasible.
For this reason, flexImaging displays a red letter indicating the normalization method used
for a data set in the upper-right corner of the Imaging Display. This indicator can be hidden
by clearing theView > View Normalization Symbol option.

Figure 2-62 Selecting View Normalization Symbol displays the normalization
indicator in the Imaging Display
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flexImaging offers four normalization methods: RMS (vector norm), TIC (mean), Median
andMass Window.

Note The presence and nature of noise are important factors in normalization
methods. For this reason, normalization is qualitatively different for MALDI-
TOF data sets (where chemical noise is present in the spectra) and for FTMS
(where no chemical noise is present in the spectra and electronic noise is
removed by data reduction).

For a detailed discussion of normalization in MALDI-TOF data sets, refer toDeininger SO,
Cornett DS, Paape R, Becker M, Pineau C, Rauser S, Walch A, Wolski E. Normalization
in MALDI-TOF imaging data sets of proteins: practical considerations. Anal Bioanal
Chem. 2011 Apr 12.

How normalization works

Amass spectrum can be considered to be a vector of intensity values:

For the normalization, each mass spectrum in the data set is divided by its individual
normalization factor f:

Normalizing a data set

To normalize a data set (or to switch normalization off), choose a suitable normalization
option from the normalization drop-down list in the tool-bar or select the desired Spectra
Normalization option in theEdit > Sequence Properties dialog.

Figure 2-63 Normalization options in the flexImaging toolbar
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Figure 2-64 Normalization options in the Sequence Properties dialog
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2.4.3.1 Overview and Applicability of Normalization Options

Option Imaging Display
indicator

Applicable to
MALDI-TOF

Applicable to
MALDI-FTMS

RMS (vector norm) V Yes Yes
TIC (mean) T Yes No
Median M Yes No
Mass Window exclusion W Yes No
Mass Window inclusion W Yes Yes

RMS (vector norm)

The RMS normalization method divides all spectra by the root mean square of all data
points and works well if all spectra in the data set are expected to have similar peak
intensities:

The RMS normalization method is applicable to MALDI-TOF and MALDI-FTMS data sets
but may be influenced to some extent by chemical noise in the spectrum. Artifacts may be
created if peaks with unusually high intensity are present in some regions (MALDI-TOF) or
significant differences in signal intensities exist in different regions (MALDI-FTMS).

The RMS normalization method usually leads to a very uniform distribution of intense
signals.

The RMS method was the only normalization method available in earlier versions of
flexImaging. Because it is more likely to produce artifacts than the TIC normalization
method, flexImaging automatically displays a warning and changes the normalization
method to TIC if archived data sets are opened.
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TIC (mean)

The TIC normalizationmethod divides all spectra by themean of all data points.

The TIC normalizationmethod is applicable to MALDI-TOF data sets. It is assumed that all
spectra have a similar area. The area of a MALDI-TOF spectrum is defined to a large
extent by the chemical noise and only to a small extent by the peak intensities. This means
that the TIC normalization method is not affected by moderate peak intensity variations in
the data set. Artifacts may be created if peaks with unusually large areas are present in
some regions, or spectra do not contain all spectral noise.

Median

This normalization method divides all spectra in the data set by the median of all data
points.

The median normalization method is applicable to MALDI-TOF data sets and is more
robust than the RMS and TIC normalization methods. Artifacts may be created if spectra
do not contain all spectral noise.

A normal MALDI-TOF spectrum contains more baseline than signals, and in such cases,
the median is a goodmeasure for the baseline or the average noise. Median normalization
is almost entirely unaffected by the intensity or area of signals in the spectra, and can
therefore be used if the RMS or TIC normalization methods lead to artifacts. However, if
the TIC or RMS methods are applicable, they will usually provide better results than the
median normalizationmethod.

Themedian normalizationmethod relies strongly on the presence of noise in the spectra. If
spectra do not contain the full symmetrical noise profile (for example, because the baseline
was cut off using the detector offset setting or the electronic gain was too low during the
acquisition), using the median normalization method will generate significant artifacts. For
this reason, themedian normalizationmethod is not applicable to FTMS data.
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Mass Window exclusion

The mass window exclusion normalization method is a TIC normalization of a selected
portion of the spectra and is applicable to MALDI-TOF data sets. Peaks that would
otherwise generate artifacts using the TIC normalization method are excluded from the
normalization.

Peaks are excluded from the normalization by defining their mass range using the distance
cursor in the SpectrumDisplay.

►► To exclude a peak from the normalization

1. Zoom in on the peak to be excluded.

2. Right-click in the Spectrum Display and select Mass Window / Distance from the
shortcut menu.

3. Using the mouse pointer, move the vertical lines to the boundaries of the peak to be
excluded.

Click to switch themouse pointer between the boundary lines.

Figure 2-65 Setting the boundaries of the mass exclusion window
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4. When the boundaries have been set, right-click to open theAdd Normalization Mass
Window dialog.

Figure 2-66 Add Normalization Mass Window dialog

5. SelectExclude window from normalization.

Additional exclusion windows can be created by defining a mass window, selecting
Exclude Window from Normalization, and selectingAdd to List of Windows.

The boundaries of exclusion windows are indicated by dashed blue lines in the
SpectrumDisplay.

6. Select theWindow normalizationmethod by either:

a. SelectingWindow in the flexImaging toolbar normalization list or

b. Selecting Edit > Sequence Properties to open the Sequence Properties
dialog and select theSpectra Normalization optionNorm. to Mass Window.

The boundaries of the normalization window(s) are displayed to the right of the
Norm. to Mass Window option.
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Figure 2-67 Selecting the Norm. to Mass Window option in the Sequence Properties
dialog

Mass Window inclusion

The mass window inclusion normalization method is a TIC normalization of a selected
portion of the spectra and is applicable to MALDI-TOF and MALDI-FTMS data sets. This
method can be used to normalize to a known signal (such as a matrix signal, a spiked
analyte, or a signal that has equal intensity throughout the entire tissue section).

Artifacts may be created if region-specific ion suppression modulates the intensity of the
internal standard.

Known peaks or spectrum ranges are used for normalization by defining their mass range
using the distance cursor in the SpectrumDisplay.

►► To use a known peak or spectrum range for normalization

1. Zoom in on the peak or spectrum range to be used for normalization.

2. Right-click in the Spectrum Display and select Mass Window / Distance from the
shortcut menu.

3. Using the mouse pointer, move the vertical lines to the boundaries of the peak or range
to be used for normalization.

Click to switch themouse pointer between the boundary lines.
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Figure 2-68 Setting the boundaries of the normalization window

4. When the boundaries have been set, right-click to open theAdd Normalization Mass
Window dialog.

Figure 2-69 Add Normalization Mass Window dialog
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5. SelectNormalize to Window.

Additional normalization windows can be created by defining amasswindow, selecting
Normalize to Window, and selectingAdd to list of windows.

The boundaries of exclusion windows are indicated by dashed red lines in the
SpectrumDisplay.

6. Select theWindow normalizationmethod by either:

a. SelectingWindow in the flexImaging toolbar normalization list or

b. Selecting Edit > Sequence Properties to open the Sequence Properties
dialog and select theSpectra Normalization optionNorm. to Mass Window.

The boundaries of the normalization window(s) are displayed to the right of the
Norm. to Mass Window option (Figure 2-67).

2.4.3.2 How to Recognize and Deal with Normalization Artifacts

Incorrectly applied normalization methods can generate artifacts that may appear to
provide useful biological or histological information. It is therefore essential to recognize
these artifacts.

A. Qualitative changes in the image with and without normalization

When a normalized and a non-normalized image are compared, the normalized image will
usually look smoother. Significant changes in the intensities of a mass’s signal — for
example, if the signal’s highest intensity is found in different regions before and after
normalization— are a strong indication of a normalization artifact.

B. Qualitative changes in the image when switching between TIC/RMS and
median normalization (MALDI-TOF only):

Images normalized using the TIC or RMS and median methods should appear similar,
with the TIC- or RMS- normalized image usually looking a bit smoother. Significant
differences in intensities between the TIC/RMS- and median-normalized image are a
strong indication of an artifact.

C. Apparent “holes” in the TIC or RMS normalized data, especially in the
distribution of noise or low intensity signals (MALDI-TOF only):

The presence of gaps in TIC- or RMS-normalized data indicates the presence of artifacts.
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D. Only a few bright pixels in median normalization (MALDI-TOF only)

The presence of just a few bright pixels is usually an indication that in many spectra the
baseline was cut off during acquisition. This can result in median values of close to zero,
and as a result, to very intense spectra after normalization.

In cases A–C the artifacts are usually caused by the presence of signals with high
intensities or large areas in some parts of the data set. Because the RMS normalization
method is more likely to generate artifacts than the TIC normalization method, try
changing the normalization from RMS to TIC. If artifacts persist, use the median
normalization method (MALDI-TOF), or manually exclude the signals that cause the
artifacts using theMassWindow Exclusionmethod.

In case D, the noise information was lost during the acquisition and the data set is not
suitable for normalization using noise-basedmethods.

Exclusion of noise spectra

The RMS (and to a lesser extent the TIC) normalization methods carry the danger of
artificially increasing the intensity of pure noise spectra. For this reason, flexImaging offers
the option of excluding noise spectra by defining a Ymean/Ymax threshold in the Edit >
Sequence Properties dialog.

Figure 2-70 Ymean/Ymax Threshold setting in the Sequence Properties dialog

flexImaging displays the Ymean/Ymax value for the data point under the mouse pointer in
the status bar (see section 1.2) . These values can be used to determine the optimal
threshold value.
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2.4.4 How to Find Biomarkers

Within this section, the term biomarker means a mass signal that is characteristic for a
specific histological feature in a tissue section, e.g. for a tumor or for an organ. (There is
also a possibility to look for biomarkers in a larger set of samples with ClinProTools. For
this approach, please refer to model generation and classification.)

If the location of the expected biomarkers is known

The workflow is explained with this data set from a sagittal zebrafish section. A histological
stain has been co- registered to make the analysis easier (the unstained section for
acquiring the MALDI data often does not show all histological features). The aim in this
tutorial is to find biomarkers characteristic for brain, heart, kidney and liver.

Figure 2-71 Zebrafish data set with co-registered histological stain
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We start by defining regions of interest for the selected organ. It is helpful to assign
meaningful names to each region (for example, "brain", "kidney", "liver" and "heart") in the
Regions Pane.

Figure 2-72 Zebrafish data set with defined regions of interest

It is necessary to check the Spectrum checkbox for the interesting regions in the Regions
Pane. This will allow the display of the average spectra of the regions in the Spectrum
Display.

There are two ways for comparing the average spectra for individual regions:
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The first is to right-click in the Spectrum Display window and select Display Type and
then select 2D Density Plot. Now, we see a 2D Density plot of the average spectra of the
selected regions and the overall average spectrum. The Region names are shown in the
upper right corner of the spectrum lanes. The intensity of the mass signals is shown as
color saturation. The saturation can be adjusted with the intensity ruler on the right side.
Dragging the ruler with the left mouse allows shifting it up and down; dragging with the
right mouse expands and shrinks the intensity scale.

Figure 2-73 2D Density plot of selected regions

The second way is to right-click the Spectrum Display and selecting Display Type and
then select 2D All Scans. Now all selected spectra are shown in an overlaid mode, each
spectrum has the color that was assigned to the respective region in the Regions Pane.

Figure 2-74 2D All Scans plot of selected regions
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Intensity differences between the selected regions can be now be easily seen in the
SpectrumDisplay. It is possible to select a mass of interest by clicking on it in the Spectrum
Display with the left mouse button (if the cursor is in Mass Filter Selectionmode) or clicking
on it with the Ctrl key pressed down (if the cursor is in Zoomingmode). Now we can cross-
check the distribution of the selectedmarker in the Imaging Display.

In the following figure, the mass at 8628m/z has been selected in the 2D density plot. The
intensity distribution of this signal shows, that it is indeed a biomarker for the kidney. It is
now possible to add themass to the result list in the Results Pane.

Figure 2-75 Kidney specific mass selected
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Now we continue with a specific mass for the heart: The 2D density plot shows a very
intensive signal in the "heart" lane at 7639m/z. Selecting this signal verifies that it is indeed
a biomarker for the zebrafish heart. We can add this mass now to the result list and in this
process populate the result list with characteristic masses. To find marker masses for the
remaining positionswewould proceed accordingly.

Figure 2-76 Heart specific mass selected
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If the location of the biomarker is unknown

Some compounds are usually not correlated directly with histological features. These are
especially compounds, which are not endogenous from the tissue itself. Examples for
these compounds are hemoglobins (which come from residual blood in the section) or
beta-defensins if inflammatory processes are present.

If the exact location of the biomarkers is unknown, one way is to select masses by clicking
on peaks in the overall average spectrum and check the distribution of the signals in the
display. The mass marker can also be dragged with the mouse in the overall average
spectrum and it can be checked how the imaging display changes. The mass marker can
also bemoved with the left and right arrow key on the keyboard.

It is also useful to find those mass signals that contribute most to the overall variance in the
data set. This can be done by performing a principal component analysis in ClinProTools.
Please refer to PCA import.

2.4.5 Creating High-Quality Images

This section provides tips on how to prepare high-quality images for talks, posters and
publications.

Getting started

Once data for a imaging run has been acquired and one or more Result Filter Lists have
been compiled, it is usually desirable to create a number of figures summarizing the
results. A good first step is to deactivate all display options in the View menu which don’t
add valuable information to a figure (typically, these are Measurement Regions, Teach
Points, Laser Spots and Sample Position). Helpful display options include Ruler, Intensity
Scale and Intensity Captions, which can be activated using the respective command from
the View menu.

The mass spectrometric results can be underlaid with the Sample Image and/or a co-
registered image for detailed evaluation of the data. Once a higher quality image has been
co-registered, there is usually no benefit from displaying the Sample Image (which can be
deselected in the View menu). Images andmass spectrometric results can be cross-faded
using the left slider in the Image Adjustment Window. In addition, if a stained image has
been co-registered in color, it can be temporarily switched to a grayscale image (using the
reg. Images as B/W command in the View menu) to prevent ambiguity when overlaying
with mass spectrometric results.
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De-activating both Sample Image and co-registered image will turn the background black
and the full color space and contrast will be available for the mass spectral image.
Frequently, normalized spectra will lead to clearer, sharper mass spectral images, so the
different Normalization options should be tested before exporting an image.

One mass filter to be shown

If the distribution of only one mass is to be shown, it is usually best to activate the Color
Gradient button in the toolbar. This “rainbow mode” exaggerates the intensity differences
in the image and usuallymakes the conclusion clearer.

Figure 2-77 The same mass filter displayed as a single color gradient and in “rainbow
mode”
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The color gradient used to display the intensity of a mass spectral peak can be fine-tuned
using the Edit Mass Filter Parameters dialog for the respective mass filter. Per default,
the measurement position with the highest peak intensity is defined as 100% and assigned
the brightest color setting. All other measurement positions are assigned colors according
to the relative peak intensity. Increasing theMinimum Intensity will cause measurement
positions with low intensities to be excluded from display (i.e. shown as black). Lowering
the Full Intensity Threshold will result in more measurement spots being assigned to
the brightest color setting.

Figure 2-78 The same mass filter displayed with increasing Minimum Intensity. More
and more measurement spots are below threshold (i.e. displayed as
black).

Figure 2-79 The same mass filter displayed with decreasing Maximum Intensity
Threshold. More and more measurement spots are above as threshold
(i.e. displayed in white).
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The histogram of a mass filter can be employed as a more objective handle when setting
these thresholds. It can be accessed by right-clicking the mass filter in the Results Pane
and selecting Show Histogram. Both thresholds are visible in the histogram as dashed
lines and can be directly adjusted here. In the example histogram shown below, only a few
pixels have an intensity 10 a.u. or higher. The Full Intensity Threshold has been adjusted
to 10 a.u., and as a result all measurement spots with intensity of 10 a.u. or higher will be
displayed asmaximum intensity.

Figure 2-80 Histogram of a selected mass filter

In addition, flexImaging 5.0 offers a Brightness optimization setting. If this option is
selected in the Edit Mass Filter Parameters dialog (accessed by double-clicking the
Mass Filter in the Results Pane), the Maximum Intensity Threshold will be automatically
adjusted in a way that puts 5% of all measurement spots above threshold. Typically,
brightness optimization leads to a clearer representation of features in the resulting mass
spectral image.
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Figure 2-81 The Edit Mass Filter Parameters dialog with the Brightness Optimization
feature selected. The Full Intensity Threshold has automatically been
adjusted, putting 5% of all spectra above threshold, as seen in the
histogram.

Displaying multiple Mass Filters

MALDI Imaging offers the unique opportunity to analyze the distribution of multiple
molecules in parallel and display them simultaneously in any combination desired once
data acquisition is concluded.

If more the one Mass Filter is selected from the Results Pane, the Result Color Gradient
(i.e. “rainbow mode”) is automatically suspended. When displaying up to three Mass
Filters in parallel, it is recommended to assign the three fundamental colors red, green and
blue, thus using the full color space and contrast are available for display. It may be
necessary to fine tune the Minimum Intensity and Full Intensity Threshold for the each
mass filter for a well-balanced image.
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Figure 2-82 Three different mass filters from a rat brain data set displayed
simultaneously

Usually red, green and blue are the preferable color setting for a computer screen or
multimedia projector, and also work fine on high quality printouts. However, these colors
are not the fundamental colors of ink-jet printers and may look rather pale on printouts
from, especially on non-glossy paper. In this a case, selecting cyan, magenta and yellow
as colors can lead to improved printouts. Cyan, magenta and yellow are not predefined in
flexImaging, but can be added using theColor dialog.
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Figure 2-83 Color dialog windows

The values for cyan, magenta and yellow are shown in the following table:

Table 2-3 Values for cyan, magenta and yellow in RGB color space

R G B

Cyan 0 164 232

Magenta 195 0 128

Yellow 255 236 0
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Although it is technically possible to display numerous Mass Filters simultaneously,
selecting more than three at a time is advisable only if each mass is distributed across a
clearly separated measurement area. Overlapping mass distribution can lead to ambiguity
in color assignments (e.g. a yellow pixel could indicate the unique presence of a mass
displayed in yellow or the simultaneous presence of two different masses coded in red and
green, whichmixes to yellow).

After a ClinProTools classification or clustering, each spectrum is very likely to belong to
only one class or cluster. Thus, the color codes for the different classes or clusters are very
unlikely to mix. It is therefore possible to show more than three colors without restriction.

Exporting Images

Once all settings have been adjusted appropriately, the easiest way to export the image is
by right-clicking in the Image Display pane and selecting the Copy Image to Clipboard
command, which will capture the image section exactly as displayed on the screen,
maintaining the currently selected zoom level and overlays. Since the position of the Ruler
and the Intensity Scale are fixed, it can be very helpful to use theWindowsRestore Down
command on the flexImaging window and scale the Imaging Display pane accordingly
before copying the image. If required, the current Spectrum Display pane can also be
exported by right-clicking it and selecting the Copy command. Alternatively, the Copy as
CSV command can be used to extract the intensity values for each individual data point on
them/z axis to the clipboard as comma-separated values.

When saving a Filter List in the Results Pane, the current selection of Mass Filters is saved
accordingly, so this function can be used to quickly access several images created for a
data set.

Page 118 of 152 flexImaging 5.0 Workflows Manual Revision D



Bruker 2 Workflows in Detail

2.4.6 Interfacing with ClinProTools

ClinProTools is a software package that allows statistical analyses of spectra collections
such asMALDI imaging data acquired using flexImaging. ClinProTools works with spectra
fromMALDI-TOFmeasurements. It does not work with FTMS spectra.

The available statistical analyses can be used for three different purposes:

l unsupervised or semi-supervised feature extraction of MALDI imaging data sets

l supervised classification of tissue

l univariate supervised statistics to find biomarker signals.

The first is mainly used to obtain concise representations of single MALDI imaging data
sets (such as an image of the main variance in the data or a spatial segmentation). Useful
for this purpose are: PCA, hierarchical clustering and PLSA. The results of these analyses
can be imported into flexImaging to create images.

The second purpose usually requires a larger collection of data that allows a statistical
model to be built for certain tissue types. This requires obtaining multiple data sets with a
known state as a training set to later classify unknown samples. The classification results
can be imported into flexImaging to create images.

The third use is important as well, but does not lead to results that could be displayed as an
image. The same is true for the comparison of different data sets by PCA or hierarchical
clustering. Therefore these uses are not discussed in thismanual.

For a full functionality, ClinProTools 3.0 or higher is required. This allows an unsupervised
principal component analysis (PCA) with normalization of the data, an unsupervised
hierarchical clustering of the data, an unsupervised probabilistic latent semantic analysis
(PLSA) and also supervised classifications on an unlimited number of spectra. For the
supervised classification, it is possible to assess the quality of a classification by outlier
detection.

With ClinProTools 2.2 no PLSA analysis is available and there is only one scaling option
(autoscaling) available for the PCA.

With ClinProTools 2.1 the PCA is only possible without autoscaling. There is no
hierarchical clustering and no outlier detection.
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With ClinProTools 2.0, no PCA and no hierarchical clustering is possible. Supervised
classifications are limited to the number of spectra that ClinProTools can load into the
program at once. No outlier detection is available.

2.4.6.1 PCA Import

An unsupervised feature extraction of imaging data can be performed with ClinProTools
2.2 and higher, and the result of this analysis can be displayed with flexImaging
(ClinProTools 2.1 can be used with some restrictions).

This is done by a Principal Component Analysis.

Principal Component Analysis (PCA)

PCA is a way to project high-dimensional data to lower dimensions while retaining the
essential information:

Imagine a set of spectra which contains 20 peaks with varying intensity. We can then
define a coordinate system with 20 dimensions, which represent the intensities of the 20
peaks. Each spectrum will occupy one point in this 20-dimensional coordinate system; the
point that is occupied is determined by the intensities of the 20 peaks of the spectrum.

The PCA now performs a linear transformation of this coordinate system in a way that the
first coordinate of this new coordinate system points in the direction of the highest variance
of the data, the second dimension points in the direction of the second highest variance
and so on. We end up with 20 new dimensions which point in declining order in the
directions of the variance of the original data.

These new coordinates are called principal components (PC). The advantage of this
analysis is a reduction of relevant dimensions. Although we have asmany PCs as peaks in
the original data set, the main variance of the data set is contained in the first two or three
PCs.

How to perform a PCA with flexImaging data in ClinProTools 2.2

The fastest way to do a PCA with ClinProTools 2.2 is to export a list of all spectra from
flexImaging and to load that list in ClinProTools 2.2. To export the spectra list do a right
mouse click in the Regions Pane in flexImaging and select the option Export Spectra
List.
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Figure 2-84 Exporting spectra list of selected region

In the Export Spectra List dialog, check the measurement region. If regions of interest
are defined, do not check them. Export the spectra list. By default the list will have the
same name as the imaging run appended by “_Regions.xml” and will be saved next to the
*.mis file.

Figure 2-85 Export Spectra List dialog
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Next, open ClinProTools and select Open Spectrum Import xml in the File menu.
Select the spectra list (please refer to the ClinProTools manual for the Settings Spectra
Preparation and Settings Peak Calculation commands in the Data Preparation

menu). After the spectra are loaded in ClinProTools, press the PCA button .

Figure 2-86 ClinProTools peak calculation of mouse kidney demo data set

After the PCA button is pressed, the PCA dialog appears where it can be defined whether
or not the data for the PCA should be normalized. (If the normalization is switched off, the
PCA will be mainly dominated by the intensive signals in the data set, because they are
likely to show the highest variance).
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Figure 2-87 PCA dialog

PressOK and the calculation starts. After the calculation the PCA windows appears which
shows the results of the PCA. At the same time, ClinProTools writes the file
“C:\BDAL\ClinProTools_2_2\Files\ClinProtPCA.xml”, which contains the results of the
PCA analysis.

Figure 2-88 Principal Component Analysis of mouse kidney demo data set
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How to perform a PCA with flexImaging data in ClinProTools 2.1

Start ClinProTools and open a model generation class. This class is a folder that contains
the spectra collection. Browse to the folder that contains the spectra of the imaging run.
See flexImaging file locations for where to find this folder. (Please refer to the
ClinProTools manual for the options on “settings spectra preparation” and “settings peak
calculation” in menu “data preparation”).

Once the spectra are loaded in ClinProTools press the “PCA” button in ClinProTools.
After the calculation a windows appears which shows the results of the PCA. At the same
time ClinProTools writes the file “C:\BDAL\ClinProTools_2_1\Files\ClinProtPCA.xml”,
which contains the results of the PCA analysis.

Figure 2-89 ClinProTools peak calculation of rat brain demo data set
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Figure 2-90 Principal Component Analysis of rat brain demo data set

There are two ways this result can be used in flexImaging

It is possible to display the scores of selected principal components for each spectrum as
color intensities in the result display of flexImaging.
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Figure 2-91 Import of one principal component in flexImaging

It is also possible to import a mass filter list which contains the masses of the peaks that
contributemost to the overall variance in the data set; this is described in variance ranking.

Import of principal components in flexImaging

In the Results Pane of flexImaging now click and in theAdd Result Filter dialog
select Import ClinProTools Result . Make sure the Mass Filter Selection Mark is not
currently displayed. If it is, hide it by pressing Ctrl+H.

In the Import ClinProTools Result dialog browse for the file “C:\BDAL\ ClinProTools_
2_ 2\Files\ClinProtPCA.xml” (if ClinProTools 2.1 is used the file will be
“C:\BDAL\ClinProTools_ 2_ 1\Files\ClinProtPCA.xml”) and in the next window select
Import Principle Component Analysis (PCA).

In the Import ClinProTools PCA dialog you can define how many PCs you want to
import. Because the file “ClinProtPCA.xml” will be overwritten each time a PCA is
calculated, flexImaging asks whether it should copy the file to the imaging run; this should
be confirmed withYes.
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The principal component filter will now be added to the actual result list. Generally it is not
useful to import more than the first six to eight PCs, which should contain most of the
variance in the data set (see figure below). It is not useful to displaymore than one PC at a
time, so select one PC (and no other filters), and the selected PC will be shown in the
result display. The result will be most conclusive if the rainbow mode is selected for the
result display.

Figure 2-92 Variance of first 8 principal components of the rat brain demo data set

What does the result mean?

If there was a homogenous sample preparation, the result of the PCA should match the
histological features of the sample. If there are distinct histological features in the sample,
such as e.g. tumor and connective tissue, or white matter and grey matter in a brain
section, one would expect that the PCA results reflect that structure. There are cases,
however, when this is not true: If the section contains masses which do not come from the
tissue itself, such as e.g. hemoglobin from residual blood, than these signals can dominate
the distribution of the first PCs. In such a case it is possible to exclude these signals from
the PCA analysis. Please refer to the ClinProTools manual for how to remove peaks from
the calculation.
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2.4.6.2 PCA Variance Ranking

The variance ranking imports masses from peaks that contribute most to the variance in
the imaging data set. To import a variance ranking it is first necessary to perform a PCA
analysis in ClinProTools, please refer to this chapter.

Import of a variance ranking in flexImaging

In the Results Pane click and in the Add Result Filter dialog select Import
ClinProTools Result.

In the Import ClinProTools Result dialog browse for the file “C:\BDAL\ClinProTools_2_
2\Files\ClinProtPCA.xml” (if ClinProTools 2.1 is used the file will be
“C:\BDAL\ClinProTools_ 2_ 1\Files\ClinProtPCA.xml”) and in the next window select
Import Variance Ranking.

In the Import ClinProTools Variance Ranking dialog, you can define how manymass filters
you want to import. If you select e.g. 10 mass filters then the 10 masses that contribute
most to the overall variance in the data set will be imported in the result list. It is
recommended to select the Insert variance into filter name option, because then the
variance is visible in the filter list.

The higher the absolute value of the variance, the more the peak contributes to the
variance in the data set. Now the masses can be selected one by one and it can be
checked if they correlate with histological features.
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Figure 2-93 One mass filter of variance ranking result of ClinProTools

Figure 2-94 One mass filter of variance ranking result of ClinProTools
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Figure 2-95 One mass filter of variance ranking result of ClinProTools

2.4.6.3 Classification by Hierarchical Clustering

The hierarchical clustering is a way to do an unsupervised classification of the mass
spectra in an imaging data set by spectra similarity. First the spectra that are to be
clustered have to be loaded into ClinProTools 2.2 (or higher). This can be done as
described in PCA import . (Please refer to the ClinProTools manual for the Settings
Spectra Preparation and Settings Peak Calculation commands in the Data
Preparationmenu).

Once the spectra are loaded into ClinProTools hit the hierarchical clustering button :
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Figure 2-96 Spectra loaded in ClinProTools

The Unsupervised Clustering dialog appears where different options can be selected:
Here it can be selected whether or not the data should be normalized, and whether or not
the PCA data should be used. If Use PCA Data is selected then it is possible to reduce
the clustering calculation to those principal components that explain the chosen % Sum
Explained Variance. (The use of PCA data must only be used with a Euclidean distance
metric!) This will have the effect that the clustering will focus more on the obvious
differences in the data set and leave out fluctuations that are more random. For the
interaction with flexImaging on whole imaging data sets, it is highly recommended to check
the Create Full Tree option. Only if this option is checked the dendrogram will be
available in flexImaging to evaluate the hierarchy of the resulting classes.
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Which parameters to select for the clustering

In hierarchical clustering there are different options available for the distance metric (that
defines how the distance between two spectra are calculated) and the linkage (that
defines how the distance between two clusters are calculated). These can be accessed
under the “advanced” settings in the clustering dialog. These parameters influence the
characteristics of the resulting dendrogram, e.g. if outlier spectra are rather found at the
top-level of the dendrogram or are grouped into existing large clusters. For the evaluation
of MALDI imaging data sets, it is desirable to have a clear structure of the dendrogramwith
large clusters at the top level. These can usually be achieved by the following parameters
for the clustering:

Table 2-4 Recommended parameter combinations for hierarchical clustering.

Distance Linkage Use PCA data

Euclidean Ward Yes, reduce to 70% explained variance

Cosine Average No!

Correlation Average No!

Note: Depending on the nature of the data set different settings can lead to better res-
ults.

Figure 2-97 ClinProTools' Unsupervised Clustering dialog
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After the calculation ClinProTools will show a dendrogram window, which visibly indicates
that the calculation is finished. Because the tree contains and displays all spectra, it looks
quite crowded. Please note that each node in the dendrogram has a specific ID number.
At the same time, ClinProTools writes two files with the clustering results,
"ClinProtClustering.xml" and "ClinProtClustering.tree.xml". Both files can be found in the
folder "C:\BDAL\ClinProTools_2_2\Files".

Figure 2-98 Full tree dendrogram created in ClinProTools

In the Results Pane of flexImaging now click and in theAdd Result Filter dialog
select Import ClinProTools Result . Make sure the Mass Filter Selection Mark is not
currently displayed. If it is, hide it by pressing Ctrl+H.

In the Import ClinProTools Result dialog browse for the file “C:\BDAL\ ClinProTools_
2_2\Files\ClinProtClustering.tree.xml” and in the Import ClinProTools ClusteringTree
dialog specify the available parameter. Because the file “ClinProtClustering.tree.xml” will
be overwritten each time an unsupervised clustering is calculated, flexImaging asks
whether it should copy the file to the imaging run; this should be confirmed withYes.
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Note ClinProTools will also generate two .xml files in the same folder
(ClinProtClustering.xml and ClinProtClustering.tree2.xml), so be sure to select
the correct file.

After the import is finished, flexImaging will show a dendrogram:

Figure 2-99 Dendrogram imported from ClinProTools

This dendrogram is the same dendrogram that was displayed after the calculation. Only
the top nodes are displayed, but it is possible to browse deeper into the dendrogram by
expanding selected branches. This is done by clicking on the “+” signs. The number in
brackets is the number of mass spectra that belong to each node. The number before can
be either the node ID or the cluster distance.

A display filter can now be created by doing a right mouse click on a horizontal branch or
the text above it:
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Figure 2-100 Selecting creation of result filter in the Dendrogram node shortcut menu

Now the result filter is displayed. The selected branch assumes the color of the filter and
the pixels in the MALDI image that are part of this class are highlighted in the same color.
The colors can be edited by a right mouse click on the respective branch. It is also possible
to hide or show the result. Note that in the Results Pane of flexImaging for each selected
branch a filter is generated. This filter contains the node ID from the tree.
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Figure 2-101 Screen shot with selected result filters and respective imaging display of a
mouse kidney data set

It is now possible to explore the hierarchical relationships between the classes, and by that
to select the classes that correspond to histological features.

2.4.6.4 PLSA Import

A probabilistic latent semantic analysis (PLSA) can be performed on MALDI imaging data
with ClinProTools 3.0.

PLSA is a powerful statistical analysis. In the context of MALDI imaging, it can with some
restrictions generate distributions of e.g. certain cell types, even if the resolution of the
imaging experiment is lower. The use of PLSA to evaluate MALDI imaging experiments is
described in: Hanselmann M, Kirchner M, Renard BY, Amstalden ER, Glunde K, Heeren
RM, Hamprecht FA. Concise representation of mass spectrometry images by probabilistic
latent semantic analysis. Anal Chem. 2008, 80(24):9649-58.

Probabilistic Latent Semantic Analysis (PLSA)

In a MALDI imaging data set, often the resolution is not high enough to measure single
cells. For each mass spectrometric pixel, the resulting spectra is therefore the average of
the contributing single cells.
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The PLSA now tries to unmix or deconvolute the MALDI imaging data set in a way that it
tries to recreate how the mass spectrum of the contributing components (such as cells)
have to look like and how the components are mixed in the tissue. With certain restrictions
the result of the analysis can be interpreted as the distribution of different cell types and the
resulting spectrum for each cell type. Restrictions are: The data set must show a
heterogeneous distribution of the single components and in the ClinProTools
implementation the user has to provide a number of expected components and the
resulting spectra can be ambiguous.

How to perform a PLSA with flexImaging data in ClinProTools 3.0

The fastest way to do a PCA with ClinProTools 3.0 is to export a list of all spectra from
flexImaging and to load that list in ClinProTools 3.0. To export the spectra list do a right
mouse click in the Regions Pane in flexImaging and select the option Export Spectra
List.

Figure 2-102 Exporting spectra list of selected region

In the Export Spectra List dialog, check the measurement region. If regions of interest
are defined, do not check them. Export the spectra list. By default the list will have the
same name as the imaging run appended by “_Regions.xml” and will be saved next to the
*.mis file.
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Figure 2-103 Export Spectra List dialog

Next, open ClinProTools and select Open Spectrum Import xml in the File menu.
Select the spectra list (please refer to the ClinProTools manual for the Settings Spectra
Preparation and Settings Peak Calculation commands in the Data Preparation
menu). After the spectra are loaded in ClinProTools, select pLSA from the menu
Statistical Analysis.
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Figure 2-104 ClinProTools pLSA calculation

After the pLSA button is pressed, the pLSA dialog appears. The pLSA is an iterative
calculation. The user has to specify three parameters, the first two “relative change” and
“maximum iterations” are stop criteria. Lowering the value for “relative change” and
increasing the “maximum iterations” will result in a longer andmore accurate calculation.

The “Number of Components” will define how many components are calculated and is
therefore very important. This number has to be defined with knowledge of the sample. A
good starting point will be the number of expected cell types in the sample.
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Figure 2-105 pLSA dialog

Press OK and the calculation starts. After the calculation the pLSA windows appears
which shows the results. At the same time, ClinProTools writes the file
“C:\BDAL\ClinProTools_3_0\Files\ClinProtPLSA.xml”, which contains the results of the
analysis.

Import of pLSA results into flexImaging

In the Results Pane of flexImaging now click Add and in the Add Result Filter dialog
select Import ClinProTools Result . Make sure the Mass Filter Selection Mark is not
currently displayed. If it is, hide it by pressing Ctrl+H.

In the Import ClinProTools Result dialog browse for the file “C:\BDAL\ ClinProTools_3_
0\Files\ClinProtPLSA.xml” and select “next”.

Because the file “ClinProtPLSA.xml” will be overwritten each time a pLSA is calculated,
flexImaging asks whether it should copy the file to the imaging run; this should be
confirmed withYes.

The pLSA filters will now be added to the actual result list.

What does the result mean?

If the right number of components was selected for the calculation, the components should
correspond with histological features, such as cell types. If there are significant differences
to histological features, then the sample preparationmight not have been homogeneous.
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2.4.6.5 Model Generation and Classification 

ClinProTools allows the generation of models based onmass spectrometric profiles and to
classify spectra according to those profiles. A model in this context is a set of peaks and
intensities that is able to separate classes of spectra according to prior knowledge, e.g.
separate spectra from cancer tissue versus epithelial or connective tissue.

Generating a model

To generate a model, ClinProTools expects all spectra of the respective training class in
one subfolder. If a model should be calculated that contains e.g. cancer, epithelial and
connective tissue spectra, it is necessary to provide three subfolders that contain the
respective spectra. This can easily be done by creating regions of interest in flexImaging.
The regions should contain typical spectra for the tissue features in question. Therefore, it
is useful to use regions that contain mainly the cells in questions, e.g. the most “pure”
cancer cell, connective tissue and epithelial cell regions of the section.

The spectra of these regions can be copied to specific folders by selecting the region in the
Regions Pane with a right mouse click and then select Export Spectra List . (For
ClinProTools 2.1 selectCopy Spectra to Folder. In this case specify target directory and
sample name, and quit the message on copied spectra). Select the regions that you want
to use for the model generation and confirm the suggested name for the *xml file. The file
will be placed next to the imaging run.

Figure 2-106 Copying regions
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Next, open ClinProTools and select Open Spectrum Import XML in the File menu.
Select the spectra list. It may be necessary to adjust the Settings Spectra Preparation
and Settings Peak Calculation in ClinProTools' Data Preparationmenu in order to get
good results. Please refer to the ClinProTools manual for details. If ClinProTools 2.1 or
lower is used, then the folder to which the region spectra have been exported has to be
selected after choosingOpen Model Generation Class in the File menu.

Generating a model from more than one section

The same workflow can be followed if a model shall be created from more than one
section, e.g. from the tumor and connective tissue regions of data sets from different
patients. A little preparation is necessary here. All spectra that define one class are copied
from the original exported spectra lists of the individual samples into one new list. This can
be done in a text or an xml editor. Bruker also provides the ClinProTools Spectra
Import XML Generator , a simple tool for creating more complex spectra lists using a
graphic interface. Please refer to the tool'smanual for detailed instructions.

Another option (and with ClinProTools 2.1 the only possibility) is to copy the spectra for the
regions in subfolders using the Copy Spectra to Folder command. After copying the
spectra of the regions to a subfolder, however, it is necessary to move the subfolders into
one specific folder for each model generation class. (The folders could be copied also, but
moving the folders will be a lot faster, if the target folder is located on the same hard drive
than the imaging data).

In such a case, it should be considered to use the Support Spectra Grouping checkbox
in ClinProTools (menu Data Preparation > Settings Spectra Preparation ). If this
option is used then each spectra collection from each patient will be treated as one
sample, and each spectrum in the region will be treated as a replicate for that sample. This
will eliminate the possibility to overweight those samples that have a higher number of
spectra in the respective region.

Classification of spectra from flexImaging with ClinProTools

For classification of imaging spectra simply select the model in ClinProTools and select
Classify in the Classification menu. You will now be prompted to select a directory with
spectra. Browse for the folder that contains the imaging spectra (see flexImaging file
locations ). It is recommended to use the Classify in Batch Mode option in the
ClinProTools general settings. Then ClinProTools will classify the spectra one by one, and
there is no limit on the number of spectra to be classified. If this option is not used, then
ClinProTools will load all spectra first before starting the classification.
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After a classification the Internet explorer will open and show the classification results.
Save this file. It is recommended to save the file next to the imaging run.

Import of classification results in flexImaging

In the Results Pane click and in the Add Result Filter dialog select Import
ClinProTools Result . In the Import ClinProTools Result dialog browse for the file
C:\BDAL\ClinProTools_2_2\Files\ClinProtClassification.xml and in
the Import ClinProTools Classification dialog specify the options for the ClinProTools
classification import. The number of classes in the ClinProTools model is automatically
detected during the import resulting in one filter being created for each class.

If for the model generation the algorithms “Genetic Algorithm”, “Support Vector Machine”
or “Supervised Neural Network” have been used, then the ClinProTools classification
result will only contain the information to which class the spectra belong. Each data point in
the result display will have the same color intensity.

If the univariate “QuickClassifier” has been used, each spectrum can belong to more than
one class with a different weight. The absolute value of the classifications for the different
classes will always add up to the number of classes. If, e.g. four classes have been used,
the weight for each class for each spectrumwill add up to four. A spectrum could therefore
have a weight for class one of three, and for class two to four for each a weight 0.33.
Because of that behavior, the color intensity of each pixel in the result can be different and
reflects that value.

This can also be used to do a simple outlier control. If a spectrum has a value of around 1.0
for all classes, it belongs to all four classes with the same likeliness. This can also be
interpreted as the spectrum belongs to no class. To exclude those spectra from being
displayed in flexImaging you can use the Treat spectra with a relative weight below
X.X as unclassified option in the import dialog. The relative weight will then be translated
into a Minimum Intensity setting, which can be modified in the Edit ClinProTools
Classification Filter Parameters dialog.

Outliers in supervised classifications

A supervisedmodel is a classifier trained with sample data sets. If two classes are defined,
then every spectrum to be classified will be forced into one of the classes. The model itself
has no information on the shape of the original spectra. This means that each spectrum
will be classified, even if its peak pattern has only little similarity with the training data sets.

flexImaging 5.0 Workflows Manual Revision D Page 143 of 152



2 Workflows in Detail Bruker

In the context of MALDI imaging, it is therefore possible to generate a model that can e.g.
differentiate between tumor and tumor-freemucosa. If thismodel is applied to tissue that is
neither, e.g. a nerve or a muscle, this tissue will be classified as either tumor or mucosa. It
is therefore up to the user to apply these models only to suited tissue. To facilitate this
decision, ClinProTools 2.2 and higher has the capability prepare the data for outlier
detection.

Preparing the outlier detection in ClinProTools

To use the outlier detection in ClinProTools (version 2.2 and higher) it is necessary to
enable the Peak Picking on Single Spectra option (in Data Preparation > Settings
Peak Calculation). If a model is generated now, then it contains information on the entire
peak pattern of a spectrum, not only the peaks that discriminate between the classes. In
the classification this information is used to score the similarity of the spectrum to be
classified with the training data set. There will be one overall score; this score will give a
value for how similar the spectrum is in comparison with all spectra used for the model
generation. For each class, there will also be a class score. This class score gives a value
for the similarity of the spectrum to each of the individual classes. Each of the scores will
have a value between 0 for low similarity and 1 for very good similarity. It is currently not
possible to automatically calculate an outlier threshold. This threshold needs to be
manually assessed, which is easiest in flexImaging. Some limitations apply, especially if
one class contains spectra with a low number of signals and other classes contain many
peaks, the spectra with a low number of peaks tend to get a very low similarity score.

Use of the outlier score in flexImaging

When flexImaging imports a classification result that contains similarity scores, it will
automatically create an additional result filter “ClinProtOverall Score”. This filter will show
the similarity score for each spectrum in the data set. Now theminimum intensity threshold
for that filter can be used to find a score that separates the “good” classifications from the
outliers. This is done by visual inspection of the result. In case of the classification of
cancer, the threshold needs to be adjusted so that only cancerous areas are visible with
that filter. The histogram view is a very helpful tool to get an idea of the distribution of the
overall score.
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Now the individual “ClinProt Class” filters can be adjusted. If such a filter is edited, the
Advanced button will enable additional settings: With Minimum Overall Score , all
spectra with less than the specified value will be excluded. It is also possible to specify a
Minimum Class Score that excludes all spectra of this class if their class score is less
than specified. In addition, the similarity score can be used as a classifier: If Use class
scores from outlier detection is checked, then the class score will be displayed directly,
and the original classification result will not be shown.

Figure 2-107 Edit ClinProTools Classification Filter Parameters dialog
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2.4.7 Exporting and Importing Data for Statistical Analysis
(Advanced Users Only)

Many statistical calculations on MALDI imaging data sets (such as t- test, ANOVA,
Kruskal-Wallis- tests, ROC, hierarchical clustering, PCA, PLSA) can be calculated by
ClinProTools (see interfacing with ClinProTools).

In some cases it may be desired, however, to do calculations that are not offered by
ClinProTools or on data types that are not supported by ClinProTools (such as MS/MS
spectra). The result of these calculations may also be imported into flexImaging (e.g.
classification results).

There are several ways to access data in flexImaging:

l Direct export of the displayed intensity values from flexImaging into a table. This is a
straight forward way to do univariate calculations in external programs.

l The data can be loaded into ClinProTools. ClinProTools can be used to do the
peak-picking and generate and export a peak list for all spectra. This table can be
used in external software. This is the simplest approach for multivariate analyses in
external software. It may not be applicable if the data set is too large to be loaded in
ClinProTools or if certain custom processing options (such as specific
normalization) shall be used. The preferred way to export the peak list is as “*.xml 3”
file. For this file a suitable stylesheet is found in the ClinProTools directory, which
allows easy editing of the table in spreadsheet program (such as Excel 2003 or
higher). See the ClinProToolsmanual for details.

l If access to the full spectra is necessary, the easiest way is to export the individual
spectra of the data set from flexAnalysis as xy text files. These files can be then
treated in the external or custom software. This gives full access to the spectral
information and is a useful way to do prototyping or individual calculations in
external software. The spectra can be exported from the batch-processing tool from
flexAnalysis. A flexAnalysis method for the export is available upon request from the
software support (maldi.sw.support@bruker.com). For FTMS spectra it is also
possible to export those as xy-files. Since signals in FTMS are much sharper than in
MALDI-TOF, it is also a viable option here to export only peak- lists after peak-
picking.
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l If a software is supposed to read the raw data directly, there is a possibility to use
Bruker’s “compassXtract” interface, which allows 3rd party access to raw data. This
requires a license agreement. For details please contact the software support.

Direct export of intensity values from flexImaging:

First a mass filter for the selected mass has to be present in the Results Pane. Right-
clicking this filter shows the Export Filter Data command, that exports the displayed
values into a text file.

Figure 2-108 The Export Filter Data command in the Results Pane shortcut menu

The resulting text file has a structure like this:

# D:\example.txt generated by flexImaging 5.0. on [date]

#spot-name value region xpos ypos

0_R00X618Y250 0.229534 0 618 250

0_R00X619Y250 0.244719 0 619 250

0_R00X620Y250 0.263511 0 620 250

0_R00X621Y250 0.241105 0 621 250

0_R00X622Y250 0.275589 0 622 250
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The spot-name is the name of the spectrum, and e.g. necessary if the result of the
calculation shall later be imported into flexImaging. The “value” represents the value that
the respective pixel has in the current display, with “1” representing the full brightness. For
most statistical calculations it will be necessary to correctly reflect the full dynamic range of
the measurement and therefore no minimum intensity of maximum intensity threshold
must be adjusted.

The “region” reflects the measurement region. If several regions of interest from the same
measurement region are to be compared, then the filter export has to be done multiple
times, with the display restricted to each region of interest once.

If data sets are to be compared across different measurements, then it is necessary to use
“absolute intensity” setting in the mass filter, with the same absolute limit for all
measurements. The absolute limit should be set to the brightest pixel off all
measurements. The easiest way to find this is by using the histogram display.

Importing data into flexImaging

Any kind of numerical data or classification can be imported and displayed in flexImaging.
This is easiest, if the data is available as a whitespace separated table with the spectrum
name (and therefore coordinate) in the first column and one or more values in additional
columns. E.g.:

# D:\example2.txt

#spot-name value1 value2 value3

0_R00X618Y250 0.229534 0 213

0_R00X619Y250 0.244719 0 476

0_R00X620Y250 0.263511 1 685

0_R00X621Y250 0.241105 1 231

0_R00X622Y250 0.275589 1 612

The import can be done in the Results Pane with theAdd > Import text result command.

If the data is available as an XML file, the import is possible via the results pane Import
xml result command.
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Appendix A

A.1 Abbreviations

Abbreviation Explanation
MALDI Matrix-Assisted Laser Desorption/Ionization
PC Principle component
PCA Principle Component Analysis
RAM RandomAccessMemory
ROI Region of Interest
SRM Single ReactionMonitoring
TFA Trifluoroacetic acid
TLC Thin-Layer Chromatography
XML Extensible Markup Language

A.2 Part Numbers

# 1839454 Software-Package flexImaging 5.0
# 1839450 License flexImaging 5.0
# 1839452 flexImaging 5.0 User Manual
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Index

A

Arbitrary arrays 59

Artifacts

recognizing 104

B

Biomarkers

finding 106

C

Classification by hierarchical clustering 130

ClinProTools 67, 106, 118-120, 128, 130, 136,
141, 146

Classification 141

interfacing with 119

Model generation 141

Co-registering images 88

Cryosections

preparing 9

D

Data acquisition

arbitrary arrays 59

flex series instruments 33, 51

FTMS instruments 56

incremental runs 59

MS/MS experiments 73, 77

spot microarrays 62

using HyStar and ftmsControl 83

Data processing

normalization 95

using flexAnalysis 91

using flexImaging 91

F

flexAnalysis 91

flexControl 7, 17, 33, 53, 60, 63, 70, 73, 87, 91

flexImaging and MSMS measurement -
SRM 81

ftmsCcontrol

Data acqusition using 83

ftmsControl 7, 51, 56, 60, 63, 70, 83

H

Histological staining 88

HyStar 83

Data acqusition using 83

I

imagePrep

matrix coating with 15

Images

co-registering 88

M

Matrix

coating with imagePrep 15
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robotic spotting 19

Model generation and classification 141

MS/MS experiments 73

MS/MS measurement - Fragments only 77

N

Noise spectra

Excluding 105

Normalization 95

O

Optical image

acquiring 29

P

Patents 8

PCA import 120

Pharmaceuticals

detecting 21

S

Sample preparation

cryosections 9

tissue sections 9

Scanning

tissue sections 29

Spot microarrays 62

Staining

histological 88

T

Tissue profiling 65

Tissue sections

coating with matrix

using imagePrep 15

preparing 9

robotic matrix spotting 19

scanning 29

V

Variance ranking 128
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